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Need Help?

There are many ways to get help with Geometry Expressions.

In both the PDF manual document and the embedded Help system you can:
e Use the table of contents to get details on using a tool, an icon or a
menu.

e Use the index for help on a particular topic, such as "parametric
equations".

Inside the Geometry Expressions Help system you can:

e Use the Search tool to find all topics based on a key word, such as
"constraints".

e Browse through help with the up - "Previous page", and down - "Next
Page" arrows ™. This will step you through the help subtopics in a
logical sequence.

e You can click on colored text which links you to more information.
Tool Tips:

When you move the cursor over any icon on the screen, the name of the
icon appears briefly below the cursor.

Linked Text

Some words in the program's Help system are highlighted and underlined.
When you place the cursor over this text, the cursor becomes the hand
symbol. This text indicates a link to more information on the subject. Click
the text to jump to the related help page.

© 2025 Saltire Software
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Many of the options in the drop-down menu bar at the top of the screen
correspond to the icons or buttons located either across the top or along
the left side of the display window.

The icons at the top of the screen represent standard Windows commands,
such as File, Edit, View, and Help. On the left side, the tool panel

provides access to functions like Draw, Annotate, Constrain, Construct,
Calculate, Symbol and Greek letters. You can show or hide this tool panel

by clicking the @ button on the main toolbar or by selecting Tools from
View menu.

Similarly, the Output window, which is used to display large expressions

below the drawing window, can be toggled on or off by clicking the (=)
button on the main toolbar or by selecting Output from View menu.

The status bar at the bottom of the window displays the following (from left
to right):
<Menu Help> <Current Mode> <Cursor Coordinates> <Angle Mode>

© 2025 Saltire Software
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@& Geometry Expressions - [m] X
File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help Menu / Main Toolbar
- e PR i a b
DEH&s XDads Rk o QQEEHB L %3 Deoo
- Variables
OCentersofCurvatureofa Hyperbola.gx OOV3|0fC355|n|-9X mniscate.gx Graph.gx
Name Value Locked
N A la 40208333 -
k 17.83005
Select t 36742813

4

Graph Document
Draw Page Tabs

v

Geometry Document Variables / Functions Panel
Annotate

Constrain Tool Panel

v

Construct / _k Eq

0.0 @1 =100
. B >
~ Functions
Calculate
& Name Value
D - A C

Symbols (-a,0) (a,0)

@ .

Greek

Drawing Window

<
Eq
X*-2-X2- Y2y 2% a%-2- Y a%-a*+k’=0

Output Window

Ready Selecting (3.94776,2.38697) Radians v | Status Bar

The Status Bar

The status bar at the bottom of the screen prompts the following
information (from left to right):

Ready Selecting (0.886339,-2.72791) Radians v
e Menu Help - summary of a selected menu item.

e Current Mode - Each icon in the drawing toolbox represents a mode.

Tools requiring additional inputs after clicking the tool will display further
prompts in this field.

e Cursor Coordinates - Displays the current coordinates of the cursor in
the diagram.

e Angle Mode - A drop down window for conveniently changing from
Radians to Degrees and visa versa. This default can also be changed in
the Preferences dialog - Edit / Preferences / Math. This mode not only
affects Constraints and Calculations in your geometry, but also this

© 2025 Saltire Software
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setting is crucial when drawing trig functions. It must be set to Radians
or your sin waves will be flat! You can still label the X axis in degrees or
radians from the Context menu, Axis Properties / Units.

© 2025 Saltire Software
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You can arrange the display as it suits you.
Tools Panel - to show/hide the Tools panel displays on the left side of
the display window, click on the Show/hide tools button @ on the main
toolbar at the top or select Tools from View menu.
Variables and Functions tool panel - to show/hide the Variables and
Functions panel displays on the right side of the display window, click on
the Show/hide variables and functions button @ on the main toolbar at
the top or select Variables/Functions from the View menu.

Arranging projects - You can open multiple project files and arrange
them in the drawing window using the page tabs.

& Geometry Expressions - O X

File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help
DR Hes&XDdadcs R o0 Qo EEB L #

O Centers of Curvature of a Hyperbola.gx O Oval of Cassini.gx %‘ﬂ Graph.gx

= X2 X2 ¥2y*42.x2.a%-2 Y2 a%-a*+k?=0

A C

= X*2.x2-¥2.y*42-x%-a%-2-Y?-a’=0
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Arranging Project Pages

You can open multiple project files for quick reference. By default files are
overlaid. Click a page tab to bring a file to the top.

Comparing drawings side by side - click the page tab and drag it to one
side, top, or bottom of the window. A shadow of the drawing gives you an

indication of how the drawings will be arranged before you release the
mouse button.

O Oval of Cassini.gx O Lemniscate.gx

= X2 x2v2y*+2.x2a%2-Y2a’=0
B

v
< >

Returning to overlaid configuration - drag one tab and position it over

the other tab. The shadow will appear only on the title bar, then release
the mouse button.

© 2025 Saltire Software
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O Oval of Cassini.gx C%

= X2 x2v2yte2-x%a%2- Y2 a%at

-a’-a"+k’=0

< >

O Lemniscate.gx

= X*2.x2v2y*te2-X?-a%-2-Y2-a’=0
B

Changing Background Color

You can now change the drawing's background color to something other
than white by the following steps:
1.Select Edit / Preferences... (or in the Mac version, Geometry
Expressions / Preferences...)
2.Click Grid, Axis, Page button

3.Change Fill Color in Background section. The color will be applied to all
pages.

© 2025 Saltire Software
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Preferences X
% Grid, axis and page properties
A
Selection =I Axes
b Line Color .Black
Line Style Solid
Geometry Line Thickness 1
AA
+| Font 10; Arial; Normal; Normal; Not Underlined; Swiss; Black
Show Label
Text & Pictures oW Habels
< Units Decimal
|:|I —|:|I Subdivisions None
Math Visible |:|
Axis Arrow No

Grid, Axis, Page
Fill Color

DWhite ;
0

(0% to 100%)

-] Major Grid
Line Color Dsilver
Line Style Solid
lina Thicknacs 1 v
< >
OK Cancel

To change the drawing's background color of a page, do the following

1. Without anything highlighted, select Edit / Properties... or right click on
the screen and then select Display Properties...

2.Change Fill Color in Background section. The color will be applied to
the current page and will be saved when saving the file. Changing
background color in Preferences dialog box won't effect it.
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Display Properties

Fill Color

\ﬁ—/
Transparency (0% to 100%)

Line Color .Silver

Line Style Solid

Line Thickness 1

Visible

| OK | ‘ Cancel
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Select Preferences from the Edit menu (or in the Mac version, Geometry
Expressions / Preferences...) to modify the program's defaults.

The default settings are grouped by type, listed on the left side of the
Preferences dialog. Click the icon to display the desired page.

These settings are also available for editing a selected object or group of
objects individually without changing the defaults, using the Selection
Context Menu.

Preferences
Selection

N

Geometry
AA

PN

Text & Pictures

X
-

Dm0l
Math

Grid, Axis, Page

-] Annotation
Line Color
Line Style
Line Thickness
+/ Font
-] Calculation (Output)
Line Color
Line Style
Line Thickness
+/ Font
Line Equation Style
-] Constrain (Input)
Line Color
Line Style
Line Thickness
+/ Font

-] Expression

Math properties

10; Arial; Normal; Normal; Not Underlined; Swiss; Black

D(140,140,140)

Solid
1
10; Arial; Normal; Normal; Not Underlined; Swiss; Black

ax+by+c=0

D(130,130,255)

Solid
1

10; Arial; Normal; Normal; Not Underlined; Swiss; (130,130,255)

oK Cancel

N

Selection

set the line color and style for each selection type.
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set font related properties for labels; color and size / style
Ii for other geometric elements.
Geometry
AN set font properties for text, the rotation angle and the
@ transparency level of an inserted picture, and the Pinned

state for Text and Pictures. Pinned Text and Pictures will
not move relative to the Page Boundaries as the result of
a Scale operation.

Text & Pictures

X set the properties for alphanumeric input and output;
H mathematical calculation defaults.
Math

set properties of the Major and Minor Grid, the coordinate
Axes, the drawing's background color, and the Page
Boundary lines.

Grid, Axis, Page

To see the possible values for each property, click the row. An icon will
appear at the right end of the row (except the Point Size selection under
the Font property -you can enter the point size directly).

(-] Math s
Angle Mode Radians
Intermediate Variable Complexity (2 to 100) 15
Precision Type Significant Figures
Decimal Digits (0 to 8) 8 Digits
Click the icon to display the selection dialog |~ or drop-down menu of
choices | ~
(=] Math

Angle Mode Radians

Intermediate Variable Complexity (2 to 100)

Precision Type Degrees

Decimal Digits (0 to 8) 8 Digits

Changing a default for a type of drawing entity will apply to all entities of
that type except ones whose properties have been individually set, by
selecting it and then choosing Edit / Properties or right clicking All
Properties from the Selection Context menu. Likewise, text, pictures or
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expressions that were individually pinned ® or unpinned “* will not be
affected by changes to the default Pinned settings.
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Geometry Expressions uses standard Windows file Open and Save

operations. Save your files regularly with the handy H icon at the top of
the screen.

The data files generated from your drawings will have the extension ".gx".

You may create multiple data files and have them open in a session. Each
file is on separate page with the tabs across the top of the drawing window.
Click the tab to view the file.

If you are preparing a multi-paged lesson, you can save the pages together
as a Workbook, with the file extension ".gxw". This is a completely
separate file from the .gx files.

The Open / Save (As) / Close Workbook file selections apply only to the

workbook. H and the File / Save commands will NOT save the workbook
files. They only affect the individual .gx files.

Files can also be arranged for comparison viewing.

& Geometry Expressions - O X

File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help

DEAHe& XOdFo i o Qe mER D #F A

.. . e - ariables
O Oval of Cassini.gx O Lemniscate.gx tangential circle locus.gx X
Name Value Locked
N A a 3.125
Locus of Circle Centers r 3.3935001
Select s 6.681299
Circle EF is tangential to both circles AB and CD.
t 1.1829137
- Observe that |AE|+|CE|=r+s, which is independent of t.
Draw Infer that the locus of E is an ellipse with foci A and C. 0.0
Press Show All to see the full ellipse. .
v —_—
Annotate -
e 0.0 @ 1 =] o0
Constrain

Functions

v

Name Value
Construct

v

Calculate

Q.

Symbols

© .

Greek

< >

Ready Selecting (10.916,7.78072) Radians v
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Wookbooks and Individual .gx Files

Workbooks are a handy way of putting lessons together.
e You can make a workbook by opening new tabs (File / New).

e You can Open .gx files that you have already created to make them part
of your workbook.

e You can create pages from a combination of the above.

& Geometry Expressions

File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help

NEHeéd YXOds k €0 Q

O Oval of Cassini.gx O Lemniscate.gx O tangential circle locus.gx

When all of the pages are together on the page tab bar, select Save
Workbook (As) from the file menu.

@ Note: saving the workbook does NOT update any of the individual .gx
files displayed in the workbook, since the workbook file is an entirely
separate file (.gxw). If you want to keep the individual .gx file up to date
with the workbook page, you must use the regular File / Save for each
page / file. But, if you forget, you can always save it from the workbook at
any time.

Likewise, saving an individual page, File / Save, of an open workbook does
NOT update the workbook file (.gxw). However, if you forget to save the
workbook, but save a page (.gx), you can always open the .gx file again
from your open workbook file and resave the workbook.

If you don't want to keep individual copies of all your workbook pages, then
you just have to remember to use the Save Workbook file selection.

However, to give the workbook pages custom names (instead of
unnamed7.gx), you must save the individual page (for example, Lesson 1
Ellipse.gx) at least once. After the first time, you don't need to continue to
save the .gx file.

Only one workbook file can be open at a time. If you open a workbook file
while other individual files or another workbook file is open, they will be
closed, after, of course, prompting you to save them if you have made
changes.
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All mathematical expressions in Geometry Expressions are written in
MathML, so you can copy and paste directly to or from any other MathML
program.

Usually the standard Edit / Copy or Ctrl-C command should work. If this
doesn't give you the desired result, try the Edit / Copy As command.
Select from the submenu of choices appropriate to your application.

If you copy an expression that uses Intermediate Variables, the algebra
system will create a function from the pasted expression.

To Paste math into Geometry Expressions it must be Content MathML.
e Maple creates Content MathML by default.

e To create Content MathML in Mathematica v6.0, execute the following
commands:

SetOptions[ XML  MathML " ExpressionToMathML, "NamespacePrefixes" >
{}, "Formats" > {"ContentMathML"}]

SetOptions[ XML MathML BoxesToMathML, "NamespacePrefixes" > {},
"Formats" > {"ContentMathML"}]

SetOptions[Export, ConversionOptions > {"NamespacePrefixes" > {3},
"Formats" > {"ContentMathML"}}]

SetOptions[ExportString, ConversionOptions > {"NamespacePrefixes" >
{}, "Formats" > {"ContentMathML"}}]

e To create Content MathML in Mathematica v7.0 or higher, execute the
following commands

ExportString[expression, "MathML", "Presentation"-> False, "Content" ->
True]

Then copy the content MathML representation (the exported mathematical
expression) as Plain Text and paste it into Geometry Expressions.
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Your installation comes with several examples - look in the Examples
subdirectory. For step by step instructions through some example sets, see
the Geometry Expressions Tutorial.pdf and Geometry Expressions

Examples.pdf which can be found under the Doc subdirectory in your Gx
installation.
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Drawing

Using the Drawing Tools

The Draw toolbox contains the drawing commands and the Selection Arrow
. The drawing commands can also be invoked from the Draw menu.

/ / / s ©)
o | \J | ¥ N | &
A EH =N

Unlike commands in the other toolboxes, Drawing commands are always
available and require no pre-selection. Many of the commands are active
until you change to a different one or press the Esc key or click the

selection arrow W, e.g. you can make multiple points until you select
another tool or press esc. The selection mode, indicated by the selection

arrow cursor, k, is used for invoking all other commands. You can find the
active command mode by noting which button is pressed or looking at the
current mode on the status bar.

/ / / 4 O

Point Line Infinite Line Vector Polygon Circle
Segment
o Y DI N ® -l
Ellipse Parabola Hyperbola Arc N-gon Curve
Approximation
A x+y \
Text Picture Expression Function

Before you start your drawing, select Edit / Preferences / Geometry to
set various attributes, such as line color / style, fill color / style and
transparency level, of the various drawing elements.

You can change the attributes of individual drawing elements by selecting
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them, right click the mouse, and choose All Properties from the context
menu.

Adding a Point

v / 7 Z\ O
© | \J | ¥ RO -
A B =N
To insert a point in your drawing, follow these steps:
1.Click the Point icon = in the Drawing toolbox or select Point from the
Draw menu.
2.Move the crosshairs - into position.
3.Click the mouse to place the point under the crosshair.
When the crosshairs are positioned over some geometry an incidence
symbol (bowtie) is displayed around the point and the geometry is

highlighted. A click of the mouse will create the point incident to the
highlighted geometry.

» C

Each point is displayed with a letter label. You can change the label from

the Select mode k

Point is a modal command. You can continue making points until you
choose the select arrow or another drawing tool.
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Adding Line Segments

AR
O \/ ) g ) o
A B =N

To add line segments to your geometry follow these steps:

1.Click on the Line Segment icon 4 in the Draw toolbox or select Line
Segment from the Draw menu.

2. Position the cursor <% in the drawing window.
3.Click the mouse to place each endpoint.

Each line segment is displayed with a letter label for each endpoint.
B

A

You can change the label from the Select mode Ik

To abort a line segment in the middle of the drawing operation, hit the
"esc" key.

Line Segment is a modal command. You can continue making segments
until you choose the select arrow or another drawing tool.

Drawing Lines

v PRPER:
o  \J N ®
A B oo N

Lines are similar to line segments except they have infinite length.

1.Click the Infinite Line icon / in the Draw toolbox or select Infinite
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Line from the Draw menu.
2.Position the line cursor + in the drawing window.

3.Click the cursor to anchor the line at the cursor position. The anchor
point will be displayed on the line.

~—

4. Move the cursor in the drawing window to position the line and click the
cursor when you get the line in the desired orientation.

Lines are infinite and do not have points associated with them unless you
specifically place one on the line.

Line is a modal command. You can continue making lines until you choose
the select arrow or another drawing tool.

Active Axes -

The x and y axes have the properties of perpendicular infinite lines. When
the crosshairs are positioned over an axis, the incidence symbol (bow tie) is

+ 4‘|L +
displayed at the intersection and the axis is highlighted 1 2

7
When the cursor is at the origin, both axes are highlighted | . Points
and End points of line segments can be placed directly on the axes without

using the Constrain / Incident tool when the bow tie is displayed.

Drawing Vectors

o 4O
o \J X N | & &
A = iy H

To add vectors to your geometry follow these steps:

1.Click the Vector icon /7 in the Draw toolbox or select Vector from the
Draw menu.
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2. Position the cursor == in the drawing window.
3.Click the mouse to place each endpoint.
Each vector is displayed with a letter label for each endpoint.

Drawing vectors is similar to drawing line segments, but vectors are
constrained with coefficients of the form:

B

A

Vector is a modal command. You can continue making vectors until you
choose the select arrow or another drawing tool.

Drawing Polygons

Sy o
o J % | & &
A B =N
You can quickly create a multisided figure with these steps:
1.Click the Polygon icon .£\ in the Draw toolbox or select Polygon from
the Draw menu.
2. Position the cursor <% in the drawing window.
3.Move the cursor and click once to place each vertex.
e As you create the sides of the polygon, each vertex is automatically

assigned a letter name. You can change the label in Select W mode.

e When you create the last side of the polygon by clicking on the first
vertex, the polygon will be filled with the default fill color, style and
transparency.

e To change the appearance of the polygon (color or style), select I} it,
right click, and choose All Properties from the context menu.

e Polygon is a modal command. You can continue making polygons until
you choose the select arrow or another drawing tool.

Polygons can be filled with the color, style, and transparency level of your
choice. See the Edit /Preferences menu, Geometry tab to set the
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default. To change the color / style /transparency level of selected
polygons, select the polygon(s), right-click, and select All Properties from
the Selection Context menu (or Edit / Properties from the menu bar).

Drawing Circles

/1 /1 7] 4
o \J ) g ® <
A B v N

To add a circle to your diagram, follow these steps:

1.Click the Circle icon O in the Draw toolbox or select Circle from the
Draw menu.

2.Move the cursor - in the drawing window to the position of the center of
the circle and click once.

3.Move the cursor to draw the circle in the desired size and click again.

Notice the circle is displayed with 2 points, the center and a point on the
perimeter.
B

Circle is a modal command. You can continue making circles until you
choose the select arrow or another drawing tool.

You can adjust the circle in Select k mode.

Circles can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab to set the default. To change
the color / transparency level of selected circles, select the circle(s), right-
click, and select All Properties from the selection context menu (or Edit /
Properties from the menu bar).
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Drawing Ellipses

Ve / 7 /Z\ O
(cJV X ~» & <
A B o\

To create an ellipse in your diagram, follow these steps:

1.Click the Ellipse icon O in the Draw toolbox or select Ellipse from
the Draw menu.

2.Move the cursor - in the drawing window to the position of one focal
point. Click to place the first focus point. Move the cursor and click
again to place the second focal point.

3.Then move the cursor to open the ellipse to the desired shape and click
the mouse a third time.

The ellipse will appear with three labeled points, the two foci and a point on
the ellipse.

The Ellipse tool is a modal command. You can continue making ellipses
until you choose the select arrow or another drawing tool.

Ellipses can be filled with the color / transparency level of your choice. See
the Edit /Preferences menu, Geometry tab, Conic properties group to
set the default. To change the color / transparency level of selected
ellipses, select the ellipse(s), right-click, and select All Properties from the
selection context menu (or Edit / Properties from the menu bar).

© 2025 Saltire Software



Tools 43

Drawing Parabolas

Ve / 7 /\ O
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To create a parabola in your diagram, follow these steps:

1.Click the Parabola icon U in the Draw toolbox or select Parabola from
the Draw menu.

2.Move the cursor - in the drawing window to the position of the
parabola's vertex. Click and drag the mouse along the major axis.
Release the mouse at the focus.

After sketching the general parabola, you can constrain it in the following
ways:

1. Click the parabola and select Implicit equation /f= from the
Constrain toolbox and type or paste the formula.

|
\

2. Constrain the vertex and focus points to some coordinate values.
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Select E
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Draw
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3. You can also adjust the parabola with the Translation, Rotation and
Dilation tools.

Drawing Hyperbolas

v / 7 Z\ O
o \ AR OB
A B v N

To create a hyperbola in your diagram, follow these steps:

1.Click the Hyperbola icon )C in the Draw toolbox or select Hyperbola
from the Draw menu.

2.Move the cursor -~ in the drawing window to the position of one focal
point. Click to place the first focus. Move the cursor and click again to
place the second focal point.

3.Then move the cursor to open the hyperbola to the desired shape and
click the mouse a third time.
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5

The hyperbola will appear with three labeled points, the two foci and a point
on the hyperbola.

The Hyperbola tool is a modal command. You can continue making
hyperbolas until you choose the select arrow or another drawing tool.

Drawing Arcs

; 4 ’ 4 O
e | \J | X% ®@ <
A [eal X S

Arcs can be placed on any of the conics - circle, ellipse, parabola, hyperbola
- or any function. Points are automatically placed at the ends of the arc.

Here are the steps:
1.First draw the conic or function which will be the basis for the arc.
2.Choose the Arc tool N and move the cursor over the section of the

existing curve where the arc will be defined. Click and drag the cursor
over the curve.
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Endpoints are automatically inserted on the arc.
Curvilinear Polygons

The Arc drawing tool ! lets you make curvilinear polygons for which you
can assign fill properties and find areas. There are some limitations,
however. Since you can't construct a point on two intersecting curves
(except for circles), you have to connect curves with line segments. If you
want to connect two arcs, you have to first connect them with a line and
move it to the intersection like this:
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/\

\/

To make a curvilinear polygon of the intersecting parabolas here are the
steps:

e Attach two lines.

e Make endpoints C and D -t point proportional along the curves.

e Make endpoints A and B t point proportional along the curves.

e Draw the two arcs - select Draw / Arc, from C to A and D to B.

e Select the sides and arcs of the polygon in order and click Construct /

Polygon.
C /\ A

\/

e Set t=2 in the Variables toolbox and the lines will become the
intersection points.
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Variables

Name Value Locked
A

a 1 -

t 2 -

It's easier with circles because you can place points on their intersections:
C
D

/ “ @)
o U X ~ <
A B =N

The N-gon tool lets you quickly draw any regular polygon. You can even

work on problems where the number of sides is n, or whatever variable you
choose.

Drawing Regular Polygons

Here are the steps:
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1.Click the N-gon button @ in the Draw toolbox.

2.Similar to drawing a circle, position the cursor to place the center of the
n-gon and click to the desired size. The n-gon at first appears to be a
pentagon.

3.In the data entry box, enter the number of sides you want or a variable
to represent the number of sides and press Enter.

Drawing Curve Approximations

/ 4 /

AN O
o U X ~N @
A B -~ N

The Curve Approximation tool will insert a specified number of points and
edges evenly spaced on a selected section of a curve or conic. This is a
great tool for introducing problems using the Trapezoidal Method of
integration. (Take a look at our Gx book, Calculus Explorations .)

Here are the steps:

1.Click Draw / Curve Approximation < .

2.Select any function, circle, ellipse or parabola and drag the cursor over
the curve.
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Note: It is best to draw your curve independent of existing points on the
curve. Then connect other geometry to the approximation points. If you
start or finish the arc with points lying on the curve (e.g. point C in the
ellipse above) and later decide to delete the curve approximation, attached
geometry may also get deleted.

Here is the area of a function using the Trapezoidal Method:
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Adding Text to the Drawing

v / 7 Z O
o U ) g ®
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To add titles or other annotation to the drawing follow these steps:

"\

1.From the Draw toolbox click the Text icon A or select Text from the
Draw menu.

2.Position the text cursor —bx at the upper left corner where you would like
your window of text located.

3.Click and drag to form your text box to the appropriate size.
4.Enter and format your text in the Edit Text dialog.

Enter mathematical statements using the Annotation / Expression tool.

© 2025 Saltire Software



52 Geometry Expressions Manual

Inserting and Editing Text

In the Edit Text dialog you can enter and format the text that will be
displayed in your defined text window.

Edit Text X
C}{D @ %‘ ('J ‘Bahnschrift SemiBold SemiConden ~ 18 v
ABC - = =F —
S b/ UEEZE=

Surface Area of a Sphere\

MEOEECIMMECEE)E)
U8 0600600 A00

Greek Lower |Greek Upper|Annotation

OK Cancel

The default text formatting for this dialog is set in Edit / Preferences /
Text & Pictures.

Using Pictures in the Drawing

7/ / 7 a O
o \J ¥ N | &
A » [N

Liven up your examples with a picture or two, or use an image for reference
points in your drawing. Here's how:

1.Click the Picture icon in the Draw toolbox or select Picture from
the Draw menu.

2.Click and drag the cursor to delimit the area where you want to place the
picture.

3.Find your image in the Select Image File dialog. Image formats
include: .bmp, .gif, .jpg, .pcx, .png, and .tif

4. After entering your images, change to Select I} mode or choose
another Draw command.
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[X=20-T

\Y=30-T-16-T

Pictures are always inserted under your drawing objects, so you can add a
picture at any time.

In Select % mode you can move a picture, as with any drawing object.
The inserted picture can be rotated and the transparency level can be set in
the Display Properties dialog box.

¢ Right click on a highlighted picture and then select All Properties

e Or select Properties from Edit menu.

Display Properties X

-] Picture
Visibility Condition
Pinned
Angle In Degrees (-359 to 359) 0

Transparency (0% to 100%) 0

OK i ‘ Cancel
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Adding Expressions
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You can type an algebraic expression in the drawing window and Geometry
Expressions will solve it with whatever information it has available. Here are
the steps:
1.From the Draw toolbox click the Expression icon X1y or select
Expression from the Draw menu.

®

"\

2.Move the expression cursor_’;y to the position where you want it to
appear in the drawing window and click to display the data entry box.

3.Enter the expression using numbers, variables, and output expression
names. Use the Symbols toolbox to help you enter mathematics.

Adding an expression to the diagram can help you work out relationships in
the geometry. Here is an example making use of the Expression tool to
see the relationship between similar triangles.

Sides a and c are perpendicular, and AC is perpendicular to BD. We
obtained the Output of lengths AD and BD using the Show Name button.
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The expression to solve is the relationship of the two lengths: Zq / Zq- The
system immediately evaluates the expression as => c/a.

Creating Functions

/ / / s ©)
o | \J | ¥ N | &
A B -

1.Click the Function icon \\ in the Draw toolbox or select Function from
the Draw menu

2.Click the drop-down list button to select the function type that you want
to use in your drawing.

Function Type X

Type: |Cartesian

Polar

Parametric
Start: ‘ ‘

End: ‘ ‘

Cancel

@ Important Note for Trig Functions: Remember that in order for
geometry to be displayed accurately on the screen, Geometry Expressions
uses equal scaling in the X and Y directions. So in order for your trig
functions to be displayed properly you must be in Radians mode - check

Radians v

Degrees

the window on the bottom right side of the screen. . No matter
what the mode, you still have a choice in labeling the X axis from the
Context menu, Axis Properties / Units.
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Cartesian Function

When you select Cartesian from the Function Type dialog, the next line
contains a general form of the function in terms of Y.

Function Type

Type: Cartesian

X

v

Y= a*X*2+b

Start: ‘

End: ‘

Cancel

12

2

-1

1 2

You can define a domain of the function by enter values for Start and End.
If you want to draw function with indefinite domain, leave these fields

blank.

You can define this function in these ways:

e Modify the formula

directly:

Function Type

Type: Cartesian

Y= a*XA3+b*XA|

Start: ‘

End: ‘

Cancel

/-’1

1 2

e Modify the function interactively using "handles". In the drawing window,
click the function to select it. Click and drag it and a circle appears on
the curve. This handle represents one of the variables in the equation.
You can click and drag this handle around the drawing. Click and drag
another place on the function and another moveable handle appears if

there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation
represents the function.

In the first example, a click of the curve gives you the b handle, the y-
intercept, and lets you drag the function up and down. Click and drag
another place on the curve and you get the a handle to change the shape

of the curve.
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-1\3/1 2 3
Variables
Name Value Locked
" la 0.77482616
b 3.7436398
b 3743638 2
M >N B —
0.5 @: 3.7436398

Notice the Variable toolbox displays the changing values as you move

the handles.

e Modify the function after it's drawn by double clicking the function tag
and changing it in the edit box.

e Modify the domain of the function after it's drawn by double clicking the

curve.

The Generic Function f(X)

To use the generic form of a function, Y=f(X), select Cartesian from the
Function Type dialog, enter f(X) in the edit window and click OK:

© 2025 Saltire Software



58 Geometry Expressions Manual

Function Type

Type: Cartesian
vy= |8 |

Start: ‘ ‘
End: ‘ ‘

Click the Functions tab of the Variables toolbox to see the values used in

the function.

You can define this function in these ways:

e Modify the edit line at the bottom of the Functions tab.
keyboard arrow keys to move through the whole function.)

(Use your

e Modify the function interactively using "handles". In the drawing window,
click the function to select it. Click and drag it and a circle appears on
the curve. This handle represents one of the variables in the equation.
You can click and drag a handle around the drawing to change the curve.
Click and drag another place on the curve and another moveable handle
appears if there is another function variable in the equation. In the
general function in this example we have 5 possible handles: f(a), f(b), f

(k), f(u), and f(v).
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Functions
Name Value
f fvl+exp((flk]-X)~ (2)-- 1) ((X-f[a])...

flv]+exp((flk]-X) * (2)--1)-(X-f[a]) * (2))/(4) 4

Polar Function

When you select Polar from the Function Type dialog, the next line
contains the general form of the function in terms of the radial coordinate,

r and the polar angle, T.

Function Type

Type: Polar

a*T+b

—r=

Start: m

End: | 6.28

Cancel

You can define this function in these ways:

\ r=T-a+b

e Modify the formula and the curve domain directly:
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Function Type X

_| Type: Polar

= a‘TA3+b

Start: m ‘

End: ‘ 6.28 ‘

e Modify the function interactively using "handles". In the drawing window,
click the function to select it. Click and drag it and a circle appears on
the curve. This handle represents one of the variables in the equation.
You can click and drag this handle around the drawing. Click and drag
another place on the function and another moveable handle appears if
there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation
represents the function.

In the example above, the second click gives you the a handle; click and
drag another place on the curve and you get the b handle to change the
shape of the curve.

Variables
Name Value Locked
1 " a 0.029754548 -
b 0.45439758
/a/_\ \
/
2 1 b4 a 0029754548 2

K>l e —

-1 '
05 @E =12

Notice the Variable toolbox displays the changing values as you move
the handles.

e Modify the function after it's drawn by double clicking the function tag.

e Modify the domain of the function after it's drawn by double clicking the
curve:
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r=T-a+b

2 4 6 / 8

Function Type X

Type: Polar
Sl -1+ 1) |

Start: ‘ 0.0 ‘
End: ‘6.28 ‘

OK Cancel

Parametric Function

When you select Parametric from the Function Type dialog, the next line
contains the general form of the function in terms of X and Y and a
parameter, T.

Function Type X ‘ X=a-sin(T)
Y=b-cos(T)
Type: Parametric ) '

X= \ (sin(T)*a)

Y= \ (cos(T)*b)

|

|

Start: @ ‘

End: ‘10 ‘
Cancel

You can define this function in these ways:
e Modify the formula and its domain directly:
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Function Type X

Type: Parametric

X= (T+(sin(T)"a*(-1)

Y= (b+(cos(*(-1)

|

|

Start: @ ‘

End: ‘10 ‘
Cancel

e Modify the function interactively using "handles". In the drawing window,
click the function to select it. Click and drag it and a circle appears on
the curve. This handle represents one of the variables in the equation.
You can click and drag this handle around the drawing. Click and drag
another place on the function and another moveable handle appears if
there is another variable in the equation.

This feature is a wonderful way to understand exactly how the equation
represents the function.

In the example above, X=T-asin(T), Y=b-cos(T), a click and drag gives
you the b handle, and lets you drag the function up and down. Click and
drag another place on the curve and you get the a handle to change the
shape of the curve.

Variables

Name Value Locked
~a 2.1427534
b 0.28105173

/W_\ b ' [0.28105173 o

/ , , , , , i
k (D) HKrumEM — -
N

01780526 (By4 |3

Notice the Variable toolbox displays the changing values as you move
the handles.

e Modify the function after it's drawn by double clicking the function tag.

e Modify the domain of the function after it's drawn by double clicking the
curve:
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U 0 U

Function Type X

Type: Parametric

X= (T+(sin(T)*a*(-1)))

Y= ‘(b+(cos(T)*(-1))) ‘
Start: \-8 ‘
End: ‘8 ‘

Piecewise Function

A piecewise function or expression can be created using the Piecewise
symbol:

DEEEEEREDE
COERODMEEE
D00PWO0GEE

or the built-in function - piecewise({expressionl, domainl},{expression2,
domain2}...,{last expression, otherwise}). The reserved word, "otherwise
is an option available for the last condition.

Here we show how to enter the sequence of values, followed by conditions:

e Create a function \\
e Double click the equation to edit.

Y=X>-a+b
L

e From the edit box click the Piecewise icon in the Symbols toolbox.
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Four small gray boxes will appear, including the one containing the
original equation.

YX?-a+b

EEEEEEEBE
QUEDODHE G
DE0EOE OEE

e Fill in your piecewise parameters - equations in the left column and their
domain in the right column. To expand the function, click the Piecewise

icon again for an additional row.

‘X -a+b X=-1
*a -1=X and X<1

DEREEEEE
A0EE0EE
D000 E0E

Here's the finished piecewise function:

@

BN
ﬁn

/

Y=‘X2‘a+b Xs-1
12-a -1=X and X<1

a+X*a X>1
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Piecewise Parametric Example

Any of the functions available in Geometry Expressions can be piecewise,
including parametric functions. Take this square for example.

1. Click the Draw / Function tool H
2. Select Parametric from the drop down Type window.

Function Type X
Type: |Cartesian 7
y= Cartesian

Polar

Parametric

Start: ‘

End: ‘

3. Enter the first value (side) for the square and the range for the
parameter values -

Hit enter. Don't worry about the shape of the function, it's not defined
yet.

X

Function Type

Type: ‘Parametric v

=<
1
—

Cancel

4. Double-click the function and select the x value

5. Click the Piecewise icon on the Symbols toolbox
6. Enter the x values for each side of the square. When you run out of
gray boxes, click the Piecewise icon again to get another row

© 2025 Saltire Software



66 Geometry Expressions Manual

7. Now do the same for the y value, select the T parameter and click the
Piecewise icon 3 times

1 T=2
7\3-T T<4
‘-1 T<6
-7+T T<8
-

|
|

Use the arrow keys on your keyboard or your mouse to move to the
next gray box.

Here is the function:

X=(1 T=2
7‘3-T T<4
‘-1 T<6
-7+T T<8

il Y=(T T=<2

‘2 T=4

"G-TTse

0 Ts8
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The Selection Arrow

N

Select

Draw

v

Annotate

v

Constrain

v

Construct

v

Calculate

O .

Symbols
Greek
When you are finished with the drawing functions, click the selection arrow

or press the [Esc] key on the computer keyboard, to enable other
functions or adjust your drawing.

With the arrow, you must first select elements of the drawing in order to
enter constraints and constructions and to output calculations.

Many of the tools require you to select multiple objects.

Selecting Multiple Objects

Many of the Constrain, Construct, and Calculate tools require that you
select more than one object.

To select more than one object:

e Click the selection arrow Ik on the tool bar.

e Hold down the CTRL or SHIFT key as you click the objects you want to
select.
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If you click the wrong object while holding down the CTRL key, click it again
and it will become unselected.

If all of the objects you wish to select fall within a rectangular region, you
can use the selection box:

e Click on the selection arrow I} on the tool bar.
e Draw a rectangle around all of the objects by clicking and dragging.

If you are using Geometry Expressions on a Smartboard, turn on
Smartboard mode to make multiple selections without using the Ctrl or Shift
keys. In this mode selections accumulate. Clicking a blank space in the
drawing clears the selections. Clicking on an item a second time unselects
only that item.

Smartboard Mode

To turn on the Smartboard mode select Edit / Preferences / Selection;
in the Selection group check (click) Smartboard mode checkbox.

—| Selection
Line Color D(255,128,0)
Line Style Solid
Line Thickness 2

Transparengy (0% +e-18696} 40
Smartboard mode

When the box is checked, selections accumulate until you click a command.
Clicking a selected item a second time unselects that item, but any other
selected items stay selected. To clear all the selections, select Clear
Selection under the Edit menu or click all the selected objects again.

Adjusting the Drawing

Click the Select arrow Ik on the tool panel on the left to move, rotate or
delete selected object(s) in the drawing.

You can change a constraint value, annotation or label by double clicking it,
retyping the value or variable and then pressing the enter key.

The Scale, Zoom and Move / Pan functions have a mouse shortcut:
e The scroll wheel on your mouse can be used to Scale the drawing up or
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down. Hold down the ctrl key while moving the wheel and the operation
becomes a Zoom.

e Right-click and drag the mouse anywhere in the drawing window to
Move or Pan.

The Move geometry icon Q is @ modal command. It stays active until
you select k or choose another mode (e.g. any Draw tool).

Constraints

Using Drawing Constraints

= ©) =8 A A
A o0¥) /(':) . “pog-
> x|~ ] &

After sketching the geometry of a problem, constrain it with measurements,
coordinates and implicit equations in real or symbolic terms. The drawing
responds automatically to the assigned input constraints. Geometry
Expressions will automatically add any constraints you leave out.

m;j‘
Since annotations may look identical to constraints, use the icon, "A ,to
Distinguish Constraints / Annotations. The icon is a toggle; to turn off
the marks, click it again.

Initially, all the constraints in the toolbox are inactive. You must first select
the parts for your drawing that will be constrained. Constraint choices are
listed below along with the drawing elements that must be preselected. Be
careful when selecting geometry objects, if extra things are selected that
are not related to the constraint (like other constraints) the constraints will
remain inactive. This can happen by mistake, especially when using the
selection box tool.

Constraint Preselected Objects

Il Distance / Length Two of any combination of points,
lines, line segments, vectors, or
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F @

[

i

Radius

Perpendicular

Angle

Direction

Slope

Coordinate

Coefficients

Tangent

Incident
Congruent
Parallel

Implicit Equation

Point Proportional Along

Curve

polygon sides.
A circle

Two of any lines, segments, vectors,
or polygon sides.

Two of any lines, segments, vectors,
or polygon sides.

A line, segment, vector, or polygon
side.

A line, segment, vector, or polygon
side.

A point

A vector

A circle or locus and a line, segment,
vector, or polygon side.

A point and a line, segment, vector,
polygon side, circle or locus.

Two or three of any line segment,
vector, or polygon side.

Two or three of any line segment,
vector, or polygon side.

A circle, line, segment, vector, or
polygon side.

A point and a line, segment, vector,
polygon side, or locus

Occasionally you may try to add too many constraints to the geometry,
causing a conflict. The system will help you correct this problem in the
Resolve Constraint Conflict dialog.
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Changing a Constraint

To change a constraint, double click it with the selection arrow % retype the
value or variable and press the enter key.

B

Distinguishing Constraints from Annotations

Your drawing is defined by Constraints on geometry elements. Annotations
are like labels and have no influence on the geometry measurements. The
original default settings (Preferences / Math) fix Constraint lines and text
in blue and Annotation lines and text in black. To further distinguish these

mﬁl‘
use the Distinguish Constraints / Annotations “A toggle button on
the main icon bar.

m;ﬂ‘
When active, the button is highlighted - A and a & is placed next to all

constraints and a @ is placed next to all annotations.
As with all toggles, you can turn these marks off with another click of the

mruj‘
“A  button.
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System Added Constraints

In Geometry Expressions, you do not need to fully constrain your model.

Any parameters you have left unconstrained are filled in by the geometry
engine.

For example, the following drawing is constrained only modulo a rigid
transformation (typical for many geometry problems).

C

So if you ask for the coordinates of any of the points, they will be given in
terms of system added variables:

C [Z-C-uo—\/a+b+c -\/a+b—c -\/a—b+c -\/—a+b+c ‘sin C00)+C—a2+b2-
=
2-c

A
— (so%)

B
L (u0+c-cosCeo),vo+c-sin @OD

Clearly the system has added variables for the location of point A, and for
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the direction of line AC.

To display these variables, check the default setting, Show System
Variables, found in the Edit / Preferences menu selection on the Math
page (left panel) under Output.

Preferences

Selection

N

Geometry

AAA

Text & Pictures

X
H

Math

Grid, Axis, Page

N

Line Thickness

Font

Expression

Font

Pinned

Math

Angle Mode
Intermediate Variable Complexity (2 to 100)
Precision Type
Decimal Digits (0 to 8)
Output

Use Assumptions

Use Intermediate Variables

Show Intermediate Variables

Show System Variables

Math properties

1

10; Arial; Normal; Normal; Not Underlined; Swiss; (130,130,255)

10; Arial; Normal; Normal; Not Underlined; Swiss; Black

[

Radians
15
Significant Figures

8 Digits

OO

OK Cancel

When checked, you will see the system variables when you select the

output:
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C [2-c-u0-\/a+b+c ~Ja+b-C ~/a-b+c - -a+h+c -sin (60j+<-a2+b2+
=
2:c

A —
- (%)

~» B
£ [u0+c-cos [90],v0+c-sin (eOD

System variable

Constraint Conflicts

If you enter a constraint for some geometry which is already constrained by
another constrained object you will see a message like the one below.

The new coordinate constraint tries to move items that are already fixed by
other constraints.

(® Discard the coordinate

O calculate the coordinate from other constraints

O Relax other constraints so the coordinate is independent
Click on the constraints to be relaxed
Conflicting Constraints: 0
Constraints Relaxed: 1

The coordinate to be added

OK Cancel Help

In this case, the Coordinate constraint was already determined by the
other two sides and an angle constraint on the triangle. There are three
ways of dealing with this problem:
1. Hit the Cancel button to leave the drawing as it was without the new
constraint.
2.Click the first button, "Calculate the coordinates from other
constraints" (the default choice). This is similar to the first choice, it
eliminates the new constraint, but also calculates the selected geometry’s
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value. In this case, the coordinates of point C would be calculated and

displayed.

3.If you choose "Relax other constraints so the coordinate is independent",

this will keep the new constraint you just entered and allow you to

eliminate one of the red highlighted constraints (figure 1). When you
select one of these constraints (in figure 2 below we clicked on 0), the
highlight changes to gray. After you click Ok, the selected constraint, the

angle 0 in this case, is calculated and displayed (figure 3).

3

Figure 2
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2

0= arccos 5+L a
= 27 2k ot

A 1 2 3 4 5

Figure 3

Distance / Length Constraint

© L & .
/ Oow) /(':) - = Beg-
> x | /- H.

The Distance / Length constraint lets you specify the following
dimensions:
e Length of a line segment, vector, or polygon side

e Distance between two points or a point and any one of the line types
listed above.

e To enter a constraint:

1.Select k the appropriate drawing object(s). When you make your
selection, the Distance / Length icon will light up .

2.Click the icon, enter the constraint value, either real or symbolic, and
press enter. You can press enter without typing a value to accept the
system's default value.

You can click the constraint and drag it to adjust its placement on the
drawing.
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Radius Constraint

AP
A o0¥) /(':) . “pog-
N —— H
— - ii= e

To specify the radius of a circle:

1.From select m{ode I} click the circle. The circle will be highlighted as well
as the icon @ .

2.Click the Radius icon, enter the constraint value, either real or symbolic,
and press enter. You can press enter without typing a value to let the
system insert a variable name.

You can click the constraint and drag it to adjust its placement on the
drawing.

Perpendicular Constraint

= g (E]) 4 A

A o0¥) /('x) . “pog-
> 1l x| ~

Any two of lines, segments, vectors or polygon sides can be constrained to
be perpendicular with these steps:

3T

1.Select k two from the line types listed above.
2.Click the Perpendicular icon |_ .

The lines are redrawn and the perpendicular constraint is attached.
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Angle Constraint

= @ b z
A o0¥) /(':) . “pog-
> x|~ ] &

Any two of lines, segments, vectors or polygon sides can be constrained
with an angle value or variable name with these steps:

1.Select [} two from the line types listed above.

2.Click the Angle icon A .

3.Enter the constraint, real or symbolic. If you enter a real value, the lines
will be adjusted to reflect the constraint.

Which Side to Constrain?

Sometimes when identifying angles, the constraint falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor over
the constraint arrow and drag it to the other side, then release the mouse
button - done!

B B
C C
A D A; D

To get the reflex angle, hold the Ctr/ key while dragging the angle symbol.

Note: The angular units are displayed in the lower right of the screen. You
can choose Radians or Degrees in this window, or set the default Angle
Mode in the Edit / Preferences / Math Properties menu, Math settings

group.
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Direction Constraint

5 @ b A [ A
/ Oow) /(':) - = Beg-
> x | /- H.

Constrain any of the line types; line, line segment, vector, or polygon side,
to a direction measured from the horizontal.

1.Select I} one of the line types listed above.

2.Click the Direction icon A .

3.Enter the constraint, real or symbolic. If you enter a real value, the line
will be adjusted to reflect the constraint.

Note: The angular units are displayed in the lower right of the screen.
Change the default (Degrees or Radians) in the Edit / Preferences menu.

Slope Constraint

= ©) =8 A A
o) /(';) st Bag-
> x|~ ] &

Specify a slope for any of the line types; line, line segment, vector, or
polygon side.

1.Select k one of the line types listed above.

2.Click the Slope icon A .

3.Enter the constraint, real or symbolic. If you enter a real value, the line
will be adjusted to reflect the constraint.

© 2025 Saltire Software



80 Geometry Expressions Manual

Coordinate Constraint

11

HaQ

/

SN
—

=
L b

You can give coordinates to any point in your drawing:

1.Select I} a point.
2.Click the Coordinate icon (x?y).

3.Enter the constraint, real or symbolic. If you enter a real value, the line
will be adjusted to reflect the constraint, even if the coordinate axes are

not displayed.

To change the coordinates shown, double click and type over the

highlighted value in the data entry box.

Constraining Vector Coeffecients

0 @ kB A

A o) /(':) et
> |l x|~ | &

You can specify coefficients for a vector with the following steps:

1.Select I} a vector.

2.Click the coefficients icon /('3).
3.Enter the coefficients separated by a comma.

Note: Don't forget the parentheses or an error message appears.
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Tangent Constraint
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Any of the line types; line, line segment, vector, or polygon side can be
made tangent to a circle or locus with these steps:
1.Select [} a line of the types listed above and the circle or locus.
2.Click the Tangent icon == from the Constrain tool box or select
Tangent from the Constrain menu.

The line and curve immediately become tangent.
Incident Constraint

0 @ kB A A
boa A= )

> x|~ ] &

Constrain a point to be incident to any other geometry; line, segment,
vector, polygon side, circle or locus with these steps:
1.Select k the point and the other geometry listed above.
2.Click the Incident icon <« from the Constrain toolbox, or select
Incident from the Constrain menu.

The point is moved to meet the line or curve, or the extension of the line.

Below is an example of the latter, point D is moved to lie on the extension
of line segment AB.
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A C A C

If you select the point or the line, incidence is indicated by a bowtie around
the point:

>
<

Congruent Constraint

= ©) =8 A A
A o0¥) /('x) . “pog-
-

Constrain two or three of any of these geometry types: line segments,
vectors, or polygon sides, to be congruent with these steps:

3T

1.Select k two line segments.

2.Click the Congruent icon 2= from the Constrain toolbox, or select
Congruent from the Constrain menu.

You will see matching congruency lines on the selected segments and a
length will be adjusted.
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Parallel Constraint

5 @ bR A A
A o) /(':) e Bog-
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Any two or three of the linear geometry types can be made parallel: line,
segment, vector, or polygon side.

1.Select I} two or three from the types listed above.

2.Click the Parallel icon 3= from the Constrain toolbox, or select Parallel
from the Constrain menu.

The geometry will be adjusted and matching symbols / appear on

the selected lines.
Implicit Equation Constraint

G bk | A A

o) /('*) s Bod-

Y

= (7] =

You can use symbolic variables to constrain geometry with an implicit
equation. Lines, line segments, polygon sides, vectors and circles and
conics can all be constrained with implicit equations.

/> 1

1.Select k the geometry.
2.Click the Implicit Equation icon /f= from the Constrain toolbox, or
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select Implicit Equation from the Constrain menu.

An input window will open next to the geometry you selected. Highlighted in
the window is a generic equation for the selected object; for a line, an
equation like - XA1+YBy+Cy =0 might appear. You can edit the equation

with different variable names or coefficients as you like. You will find these
variables added to the variable list in the Variables toolbox.

Point Proportional Along a Curve Constraint

5 F kb
A o) /("‘)

A
X A
x x4
A point proportion t along a curve is defined variously for different types of
curves as follows:
e For a Line segment AB, it defines the point (1-t)-A + t-B
e For a Circle it defines the point on the circle which subtends angle t at
the center.
e For a Locus or envelope, it defines the point at parameter value t.
e For general Cartesian functions, it defines the x value of the point on the
function.
e For Polar functions, it defines the point on the function which subtends
angle t.
e For general Parametric functions, it defines the point at parameter
value t.
e For an Ellipse of the form X2/a2 + Y2/b2 =1 it defines the point (a cos(t),
b sin(t)).
e For a Parabola of the form Y=X2?/4a it defines the point (2at, at?)
e For a Hyperbola of the form X2/a2 - Y2/b? =1 it defines the point (a/cos(t
), (b sin(t))/cos(t)).
1.Select k a point and one of the curves mentioned above.

2.Click the Point Proportional icon H_ from the Constrain toolbox, or

select Point Proportional from the Constrain menu.

3.Enter the parameter or quantity (symbolic or real) in the data entry
box.

yal

s
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For example, in the following diagram, D is defined proportion t along AB,
and E is defined proportion t along BC. The curve is the locus of F as t
varies between 0 and 1.

X2 X XXX X Y2 by y sty Aty Y,
: b
1-t+? 1t

In the following example, the curve is the locus of the point (x,x2).
Tangents are created at points with parameter values x, and x; on this

curve.
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Where is Point proportional along curve for conics?

The best way to understand the location of Point proportional along
curve command for conics is to see how we construct it geometrically for
each conic:

Ellipse

The ellipse with foci A and B is inscribed in circle, center M. Draw the
radius MN at angle t to the major axis and drop the segment NO
perpendicular to the major axis of the ellipse. When the intersection of NO
with the ellipse (point C) is constrained to be t proportional along the
ellipse, it's coordinates will be (a cos(t), b sin(t)).

N

C a-cos(t),b-sin(t)
“ a0 b>0

Parabola

C lies on the parabola and BC is perpendicular to the axis AB of the
parabola. Point D is located proportion t along the segment. Point F is the
intersection of the perpendicular to BC through D with the parabola. It has

the coordinates (2at, at?) when it is constrained to parametric location t on
this parabola.

2-a
| a=0

=

Hyperbola
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CD is the perpendicular projection of C onto the axis of the hyperbola, GF is
the circle centered at the center of the hyperbola which goes through the
intersections of the hyperbola with its axis. H is the point of contact of this
circle with the tangent from D. We can see that the angle DGH is the same
as the parameter value. When point C is constrained to be at parametric
location t along the curve, its coordinates are (a/cos(t), b sin(t)/cos(t)) on

this hyperbola.
a b-sin(t)
C /= | cos(t)’ cos(t)

|a>0 | b>0

Constructions

Creating Constructions

""""" _%_ .,_l:Lu ~ ——
L /f ' | a
J “+ Y L

After sketching and constraining your drawing there are a whole set of
constructions that can be applied to the geometry. First you must select the
geometry elements which pertain to the construction. When you select the
geometry the appropriate constructions will be highlighted.

The following table lists the Constructions, their icons, and which
elements must be preselected to activate the constructions. Be careful
when selecting geometry objects, if extra things are selected that are not
related to the construction, the construction icons will remain inactive. This
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can happen by mistake, especially when using the selection box tool.

Construction
Midpoint

Intersection

Perpendicular
Bisector

Angle Bisector

Parallel

Perpendicular

Tangent

Polygon

Reflection

Translation

Rotation

Dilation

Preselected Objects
A line segment, vector, or polygon side.

Two of: a line, segment, vector, polygon
side or conic. Conics are limited to
intersecting only with lines, segments and
vectors.

A line segment, vector, or polygon side.

Two of: a line, segment, vector, or polygon
side.

A point and one of: a line, segment, vector,
or polygon side.

A point and one of: a line, segment, vector,
or polygon side.

A circle or curve, and optionally, a point on
the curve

Three or more connected line segments or
points (vertices) to form a polygon

One or more objects

One or more objects

One or more objects

One or more objects
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“‘fb Locus A point or line that will vary with a parameter
& Trace One or more objects that will vary with a
parameter
Area Under Arc An arc of a Cartesian function

Midpoints of Line Segments

FIE[ 2 [ =
L A ® 4
J 4 % |4

You can construct a midpoint on any line segment, vector, polygon side, or
between two points by:

1.Select k two from the geometry types listed above.

2.Click the Midpoint tool ----, or select Midpoint from the Construct
menu.

A point will appear in the middle of the selected line.

Intersections

nnnnn L[ e[ =
I | a

J T L
You can construct a point of intersection between any of the line types in
your geometry; line, segment, vector, polygon side or circle. You can also

construct intersections of circles. Conics are limited to intersections only
with lines, segments or vectors.

1.Select I} two from the line types listed above.
I
2.Click the Intersection tool i~ or select Intersection from the

Construct menu.
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A new point and label will appear at the intersection. If the lines are
segments that do not intersect, a point will be created at the extension of
the lines as with line segments AB and CD below.

B

[

E C"\,

D

If the geometry will never intersect, the selected objects are moved to form
the intersection. In the example below, the infinite line and circle become
tangent at the newly created point, H.

/O £

Perpendicular Bisector

-+- R
i f ’ | A
S L

You can construct a perpendicular bisector on any line, segment, vector, or
polygon side with these steps:

1.Select k any of the line types listed above.

2.Click the Perpendicular Bisector tool =

1. or select Perpendicular
Bisector from the Construct menu.

An infinite line will appear at right angles to the selected line.
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Angle Bisector
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You can bisect the angle between any combination of line types; line,
segment, vector, or polygon side with these steps:

1.Select I} two of any of the line types listed above.

2.Click the Angle Bisector tool 7L/ or select Angle Bisector from the
Construct menu.

An infinite line will appear between the two selected lines. You can use the
Calculate / Angle tool to get the value of the bisected angle.

Parallel Constructions

nnnnn S
n_‘_ /f ' 4-|-> a
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You can construct a line, through a point, and parallel to another line,
segment, polygon side or vector with these steps:

1.Select I} a point and a line of one of the types listed above.
2.Click the Parallel tool 2= or select Parallel from the Construct menu.

A line is constructed which is parallel to the selected line and passes
through the selected point.
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Perpendicular Constructions
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You can construct a line, through a point, which is perpendicular to another
line, segment, polygon side or vector with these steps:

1.Select [} a point and a line of one of the types listed above.

2.Click the Perpendicular tool -* or select Perpendicular from the

Construct menu.

A line is constructed which is perpendicular to the selected line and passes
through the selected point.

Tangents

h. £ =
I >+

J o Y L
You can construct a line that is tangent to a circle or curve with these
steps:

1.Select k the circle or curve. You can also select a point on the curve so
that the tangent goes through the point on the curve.

2.Click the Tangent tool 'f‘ or select Tangent from the Construct menu.

A line tangent to the selected curve will appear at the point where you
selected the circle or curve, or at the selected point.
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Polygon Construction
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If you created a polygon with the line segment tool, or your polygon was
not shaded for some reason, (e.g. the drawing of the sides was interrupted

or out of order) you can make joined line segments into a polygon that can
be selected with a single click using this construction.

1.Select k the line segments that make up the polygon.

2.Click the Polygon tool ’ in the Construct toolbox, or select Polygon
from the Construct menu.

The polygon will be filled and you can now select the entire polygon with a
single click.

Reflection

You can reflect any subset of your diagram about a line with these steps:
1.Select I} one or more geometry objects to reflect.

2.Click the Reflection tool *I* in the Construct toolbox, or select
Reflection from the Construct menu.

3.Either click the cursor to place the reflection line on the screen, adjust
the angle and click again, or select an existing line as the reflection line.

A copy of your selected geometry will appear on the other side of the
reflection line.

Notice all points on the reflected geometry are written as "prime", i.e. A
becomes A'. If you reflect the geometry again, A' becomes A".
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Translation
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You can translate any subset of your diagram with a translation vector.
Here are the steps:

1.Select [} the geometry to be translated.

2.Click the Translation tool .”" in the Construct toolbox, or select
Translation from the Construct menu.

3.Click the cursor to draw the end point of your translation vector and
move the cursor to establish the length and angle of the translation. Click
again to finish the vector.

The translated geometry appears. You can adjust the position of the
translation by clicking and dragging the tip of the vector.

Notice all points on the translated geometry are written as "prime", i.e. A
becomes A'. If you translate this geometry again, A' becomes A".

Rotation

i :.-l:.., £ ——
i f ’ | A
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You can rotate any subset of your diagram about a point. Here are the
steps:

1.Select k the geometry to be rotated.

2.Click the Rotation tool } in the Construct toolbox, or select Rotation
from the Construct menu.

3.Click the screen to place your rotation point.

4.1In the data entry box presented, enter the angle of rotation.

The rotation of the selected geometry appears.

Notice all points on the rotated geometry are written as "prime", i.e. A
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becomes A'. If you rotate this geometry again, A' becomes A".

Dilation
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You can dilate any subset of your diagram from a point. Here are the steps:
1.Select k the geometry to be dilated.

.

+
2.Click the Dilation tool 3" in the Construct toolbox, or select Dilation
from the Construct menu.

3.Click the cursor on your dilation point.
4.In the data entry box presented, enter the dilation factor.

The dilated geometry appears.

Notice all points on the dilated geometry are written as "prime", ji.e. A
becomes A'. If you dilate this geometry again, A' becomes A".

Locus of Points / Envelope
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You can construct a locus of points or envelope from a selected point or
line, by defining a range for some constraint in the drawing. Just follow
these easy steps:

1.Select k the point on the drawing that will form the locus (point B in the
example below); select a line, line segment, or vector to form an
envelope.

2.When you click the Locus icon rb , the Edit Locus dialog pops up.
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Edit Locus X

Parametric Variable |t

Start Value ‘0.0
End Value ‘ 15‘
OK Cancel

3. You need a parameter to drive the motion to create the locus. Click the
arrow key to the right of the Parametric Variable window to select from
a list of all variables in the drawing. (If you entered the needed constraint
in real terms, Cancel the trace and change the constraint to a variable by
double-clicking it in the drawing window.)

Edit Locus x

Parametric Variable |a

Start Value E
R
OK Cancel

4. Simply fill in the values for the appropriate variable and click the Ok
button.

13
12
11
C
3 2 A A 1 2 3 4 5

@ Note: The locus only works if the figure's position is fixed i.e. a point in
a triangle will not work as a locus unless the location of the other two points

are fixed with coordinate constraints.
To adjust the range of the locus, double-click the locus to edit the dialog.

The following example shows an envelope of the line DE. We use the Point
proportional along curve constraint and the parameter t to position the
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points D and E (D is (1-t) along line AC and E is t along line AB). In the Edit
Locus dialog, we create the envelope from parameter t as it ranges from 0
to 1.

| . Variables
O Locus of points, envelope.gx | ced
Name Value Locke
N B ~ e 038
Select
Draw E
=
I v
Annotate
= .
.v C
Constrain A D ‘ ‘ ‘ ~
t 0.38
uuuuu b R
Construct | ~ K> >runerm — .
<>
l!—| | o '
e 2| <
«i>
e | 2B [ )AL i

You can replay the creation of the envelope with the Animation tools. Select
variable t and click the Play button.

Trace
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You can Trace the movement of one or a group of drawing objects. You
can create string art drawings and see how an envelope curve is formed.
Here are the steps:

1.Select k the drawing objects to be traced.

2.Click the Trace tool & and the Edit Trace dialog pops up.

3.You need a parameter to drive the motion of the trace. Click the arrow
key to the right of the Parametric Variable window to select from a list
of all variables in the drawing. (If you entered the needed constraint in
real terms, Cancel the trace and change your constraint to a variable by
double-clicking it in the drawing window.)
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Edit Trace X Edit Trace X
Parametric Variable 0 w7 Parametric Variable |0 7
Start Value ‘ 0.0 Start Value ab
End Value \ 6.28318530717959 \ End Value X
Count ‘ 45 Count Y

oK Cancel m

4. Simply fill in the values for the appropriate variable and click the OK
button.

A (0,0) c (a,0)

To adjust the range or number of traces, double-click one of the traces to
edit the dialog.
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Area Under the Arc

The Area Under Arc function is found only in the Construct menu at the
top of the main window. Here are the steps:

1. Select an arc drawn over a function.
2. Select Construct / Area Under Arc.

A filled area is created between the arc and the X axis. The necessary lines
and points containing the area are automatically added.

Reflection

Translation

Rotation

Dilation

Locus

Trace

Area Under Arc%

D E

Drag the handles of the original function and the area under the curve
changes accordingly.
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D E

This is a great way to illustrate the definite integral.

Note: this only works for arcs drawn on functions. For arcs drawn on
conics, create the sides with the Draw / Line Segment, select all sides
and use the Construct / Polygon tool. See also: instructions for
creating curvilinear polygons.

Integral Calculus

The Area Under Arc function is a great way to show problems with the
definite integral.

Here are the steps for making the integral of the generic function f(x) over
the interval o to B:

1.Select the Draw / Function tool and enter f(x) in the Y= data entry
box. Click OK.

2.Use the Draw / Arc tool to trace over some portion of the function.

3.Select the new arc - be careful not to select the whole function. Just the
section of arc should be highlighted.

4.Choose Area Under Arc from the Construct menu. The area between
the arc and the X axis will be filled.

5.For each endpoint of the arc, use the Constrain / Point proportional
along curve tool to define the limits of the region, e.g. select o and B
from the Symbols toolbox.

6.Select the area under the arc and click Calculate / Symbolic / Area.
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IC D I I

Annotations
Applying Annotations

— E | A

A / : A

> A == >

Annotations allow you to add constraint information to your drawing which
isn't needed for it's construction. These might be constraints that cause the
geometry to be over constrained, but you might want to give the viewer
some additional information. This feature can be very helpful for making up
texts or worksheets.

Annotate tools are similar to Text in that they have no influence on the

geometry engine, even though they are placed exactly like the Constrain
tools.

Since annotations may look identical to constraints, use the icon from icon

m;j‘
bar “A at the top of the window to Distinguish Constraints /
Annotations. The icon is a toggle; to turn off the marks, click it again.

The Symbols toolbox is available to the Annotate tools.
Here are the Annotate tools and the object(s) to preselect:

Annotation Preselected Object(s)
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I—1  Distance / Length |A line segment, vector, or polygon side, or a
point and one of these line types
(perpendicular distance), or two points.

Radius Circle

8 Perpendicular Two of any line, segment, vector, or polygon
side.

_,é_ Angle Two of any line, segment, vector, or polygon
side.

A Direction A line, segment, vector, or polygon side.

/| Slope A line, segment, vector, or polygon side.

xy) | Coordinates Point

/(';} Coefficients Vector

= Congruent A line, segment, vector, or polygon side.

polygon sides
Parallel A line, segment, vector, or polygon side.

——
_‘A Congruent Angle | Two of any lines, segments, vectors, or
——
—
% Expression [none]

Distance / Length Annotation

— E | A
A / : /I' )
=S A = 2

Length annotations may be applied to any line, segment, polygon side or
vector. Distance annotations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:

1.Select k the line segment, or point and line, or pair of points as
described above. When you make your selection, the drawing objects

will be highlighted and the Distance / Length icon will light up o
2.Click the icon
3.Enter the distance information. There are no format restrictions. You

can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.
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You can click the annotation and drag it to adjust its placement in the
drawing.

Radius Annotation

s R
~ / )
-2 4 3 >

To annotate a circle's radius use these steps:

1.Select I} the circle. The Annotate / Radius icon will light up and
the circle will be highlighted.

2.Click the icon
3.Enter the radius information. There are no format restrictions. You can

use Symbols and Annotation Symbols in the entry. Press enter when
you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Perpendicular Annotation

The perpendicular annotation inserts the perpendicular mark between any
two of these line types: line, segment, polygon side or vector. Use these
steps:

1.Select k two of any line, segment, vector, or polygon side. The

Annotate / Perpendicular icon |l will light up when both lines are
highlighted.

2.Click the icon.
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E
F
D
cC G B

Note: Placing this annotation between two lines does not change the
relative position of the lines or prevent the lines from changing their
relative position as it does with the Constrain tool of the same name.

This annotation is very useful if you are displaying a 3-d object. In this
example we imported the Triangular Prism from the Solids folder in the
Figure Gallery.

N
L]

= b
A /
> =

To annotate an angle use these steps:

Angle Annotation

N[ ‘\ 1>

1.Select I} two of any line, segment, vector, or polygon side. The
Annotate / Angle icon A will light up and the lines will be highlighted.

2.Click the icon
3.Enter the angle information. There are no format restrictions. You can
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use Symbols and Annotation Symbols in the entry. Press enter when
you're done.

Which Side to Annotate?

Sometimes when identifying angles, the annotation falls on the wrong one.
In the example below, we wanted BDC, not BDA. Just click the cursor over

the annotation arrow and drag it to the other side, then release the mouse
button - done!

B B

A D A D

To get the reflex angle, hold the Ctr/ key while dragging the angle symbol.

2-17-0 A
/Q
N /C
B
N
Direction Annotation
— E | A
/ : 4
> A == 5

To annotate a line's direction use these steps:

1.Select I} a line, segment, vector, or polygon side. The Annotate /

Direction icon A will light up and the line will be highlighted.
2.Click the icon

3.Enter the direction information. There are no format restrictions. You
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can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Slope Annotation

— E | A
/ |
> A x| 3

To annotate a line's slope use these steps:
1.Select I} a line, segment, vector, or polygon side. The Annotate /
Slope icon A will light up and the line will be highlighted.

2.Click the icon

3.Enter the slope information. There are no format restrictions. You can
use Symbols and Annotation Symbols in the entry. Press enter when
you're done.

You can click the annotation and drag it to adjust its placement in the
drawing.

Coordinate Annotation

] L L
Lo
> & | x| 3

To annotate an point's coordinates use these steps:
1.Select k point. The Annotate / Coordinate icon Coy) will light up and
the point will be highlighted.
2.Click the icon

3.Enter the coordinate information. There are no format restrictions. You
can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

You can click the annotation and drag it to adjust its placement in the
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drawing.

Coefficients Annotation

] ol
Lo
D A 3=

To annotate a vector's coefficients use these steps:

1.Select I} vector. The Annotate / Coefficients icon /(’il‘ will light up and
the vector will be highlighted.

2.Click the icon

3.Enter the vector's coefficients. There are no format restrictions. You

can use Symbols and Annotation Symbols in the entry. Press enter
when you're done.

B

/
s

You can click the annotation and drag it to adjust its placement in the
drawing.

Congruent Annotation

— B | A
: %)

X
b=

Place a congruent mark on any of the linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:

1.Select I} any line, segment, vector, or polygon side. The Annotate /

Congruent icon 2= will light up when both lines are highlighted.
2.Click the icon.
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C

Note: Placing this annotation on lines does not change the relative lengths
of the lines or keep them the same length as it does with the Constrain
tool of the same name.

Congruent Angle Annotation
— E | A

~ -

Place a congruent mark between pairs of linear drawing elements: lines,
segments, vectors, or polygon sides. Use these steps:

X
2

1.Select k two lines, segments, vectors, or polygon sides. The Annotate

/ Congruent Angle icon Awill light up when both lines are
highlighted.

2.Click the icon.

You can change the arc count with these steps:
1. Select the annotation.
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2. Right click to invoke the selection Context menu.

3. Select Tic/Arc Count from the menu and click the desired number.

Parallel Annotation

F G

Cut

Copy

Copy As

Send to Mathematica
Paste

Delete

Hide

Arrange

Congruence Style
Line Properties
Show Arrowheads
Show Symbol
Text Properties
Tic/Arc Count

All Properties...

=8

(x,¥)

/
s 2 (=)

Ctrl+H

I

_A
7

(5
X
2

U A W N =

Place a parallel mark on any of the linear drawing elements: lines,

segments, vectors, or polygon sides. Use these steps:

109

1.Select k any line, segment, vector, or polygon side. The Annotate /

Perpendicular icon == will light up when both lines are highlighted.
2.Click the icon.
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/ B
b G
A
Note: Placing this annotation on lines does not change the relative position

of the lines or prevent the lines from changing their relative position as it
does with the Constrain tool of the same name.

Expression Annotation

= b
A | 4 | & |
- -

The Annotate / Expression command is useful for placing a line of
mathematics anywhere in your drawing.
X

1.Click the icon 2.

2.Move the cursor to the position where you want to place the expression
and click.

3.Enter the expression. There are no format restrictions. You can use
Symbols and Annotation Symbols in the entry. Press enter when you're
done.

= b

|

You can click the annotation box and drag it to adjust its placement in the
drawing.

Calculations
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Calculating the Output

Symbolic
,!:!, @ A _\ A (:v)
e O 4 = i-
Real
0 @ L A / o
e O 4 = /-

Geometry Expressions will make calculations in the geometry based on any
constraints or constructions you have specified, or just from the sketch.
Calculations can be output in Real or Symbolic terms by choosing the
appropriate button.

If you haven't supplied all of the necessary input constraints, the system
inserts any missing variables automatically or, for real calculations, bases
the value on the sketch.

Some calculations may take longer than you expected. If the calculation
isn't immediate, you can stop it and restart it with these buttons on the tool
bar.

2%
L of Stop calculations

6’ Start calculations.

You may want to reconsider the problem, add constraints, or just let it
continue with the calculation.

The Stop calculations and Start calculations can also be found under
Calculate (Output) menu and under the general context menu.

The table below lists all the available calculations and geometry elements
which must be preselected. Be careful when selecting geometry objects, if
extra things are selected that are not related to the calculation (like other
calculations) the calculations will remain inactive. This can happen by
mistake, especially when using the selection rectangle.

Calculation Preselected Object(s)

= Distance / Length |A line segment, vector, or polygon side, or
a point and one of these line types
(perpendicular distance), or two points.

Radius Circle

A Angle Two of any line, segment, vector, or
polygon side.
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A Direction A line, segment, vector, or polygon side.
/| Slope A line, segment, vector, or polygon side.
) Coordinates Point

- ) Area Circle or polygon
O Perimeter Circle or polygon

( ) Coefficients Vector

Y

fﬁ Parametric A line, segment, vector, polygon side,
Equation circle, or a constructed locus.

/fz Implicit Equation A line, segment, vector, polygon side,

circle, or a constructed locus.

Distance / Length Calculation

Symbolic
@ A A / &
e O 4 | K r~

Real
g[A]A] 4|
| h | e

Length calculations may be obtained for any line segment, polygon side or
vector. Distance calculations are available between two points, or the
perpendicular distance between a point and a line, segment, polygon side,
or vector. Use these steps:

1.Select I} the line segment, or point and line, or pair of points as
described above.

2.Click either the Symbolic or Real Distance / Length tool in the
Calculate toolbox or select Distance / Length from the Calculate
menu.

Geometry Expressions displays the length, using any relevant parameters
you may have specified.

© 2025 Saltire Software



Tools 113

Radius Calculation

Symbolic

- T
e O 4 | K r~

Real

- N R
® O 4 | fF

Geometry Expressions will calculate the radius of any circle. Use these steps
to find the radius:

1.Select I} a circle.

2.Click the Radius tool in the Calculate toolbox or select Radius from
the Calculate menu.

The equation with real or symbolic terms appears in the diagram.

Angle Calculation

Symbolic
’

= @ /_\ / ooy
8 O 4 | A -

Real
! @ A / o
® O 4 |

Geometry Expressions will calculate any angle between lines in the
geometry. Use these steps to find the angle:

1.Select I} two line types - any line, segment, vector, or polygon side.
2.Click the Angle tool in the Calculate toolbox or select Angle from the
Calculate menu.

The equation with real or symbolic terms appears in the diagram.
You can obtain the angle's supplement by dragging the angle symbol.
To get the reflex angle, hold the Ctr/ key while dragging the angle symbol.
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Supplementary and Reflex Angles

If it's unclear whether a calculation is requested for the angle or its
supplement, you can drag the angle symbol to the correct position.

Here are some examples of playing around with supplementary angles
(inputs, outputs and angle annotations all have this feature):

Select and drag to get the supplement angle

B the output changes
automatically
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Direction Calculation

Symbolic
=G T / &
® O 4 | | =
Real
| G L / o
e O 4 | K| I~

Geometry Expressions will calculate the direction of lines, segments,
polygon sides, or vectors with these steps:

1.Select I} a line type.

2.Click the Direction tool in the Calculate toolbox or select Direction
from the Calculate menu.

The direction measurement appears in real or symbolic terms.

Slope Calculation

Symbolic
| & A A o
® O 4 | | =
Real
| G A A o
® O 4 f ~

Geometry Expressions will calculate the slope of lines, segments, polygon
sides, or vectors with these steps:
1.Select I} a line type.
2.Click the Slope tool in the Calculate toolbox or select Slope from the
Calculate menu.

The equation for the slope with real or symbolic terms appears in the
diagram.
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Calculate Coordinates

Symbolic
l!:\!a @ A /_\ A (xljv)
e O 4 A -

Real
= @ AT s
® O 4 K

You can calculate the coordinates of any point in your diagram with these
steps:
1.Select I} a point.
2.Click the Coordinates tool in the Calculate toolbox or select
Coordinates from the Calculate menu.

The real or symbolic coordinates appear by the point.

Area Calculation

Symbolic

A /_\ A (xljv)

=IRC!
(@) 0 4 & »«

Real

WAY /_\ / o0¥)

IR,
()0 4 & @

You can obtain the area of any polygon or circle in your diagram.

Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then proceed
with these steps:

1.Select k a circle or polygon.

2.Click the Area tool in the Calculate toolbox or select Area from the
Calculate menu.

The area is displayed in real or symbolic terms.
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Perimeter Calculation

Symbolic
A /_\ A (xljv)
(5= (r-

@@
AN

L

Real

] @ L A Vi i
e (O] 4 & n~

You can obtain the perimeter of any polygon or circle in your diagram.
Note: If your polygon is not filled it is just a group of line segments. To
convert them to a polygon, use the Polygon Construction tool, then proceed
with these steps:

1.Select k a circle or polygon.

2.Click the Perimeter tool in the Calculate toolbox or select Perimeter
from the Calculate menu.

The perimeter is displayed in real or symbolic terms.

Calculate Coefficients

Symbolic
l!:\!a @ A /_\ A (xljv)
e O f= |

Real
] @ L A Vi i
e O AN

Use this tool to calculate the coefficients of a vector in the diagram with
these steps:

1.Select I} a vector.

2.Click the Coefficients tool in the Calculate toolbox or select
Coefficients from the Calculate menu.

The real or symbolic coefficients appear by the vector.
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Calculating Parametric Equations

Symbolic
l!:\!a @ A /_\ A (:v)
8 O 4 z

Real
= @G A A /
e O 4 -

Computes parametric equations for a locus or envelope, based on the
parameter defining the curve.

You can also calculate parametric equations for a circle or line.
Use these steps:

1.Select I} any geometry object described above.

2.Click the Parametric Equation tool in the Calculate toolbox or select
Parametric Equation from the Calculate menu.

The real or symbolic equations for x and y appear by the geometry.

Calculating Implicit Equation

Symbolic
l!:\!a @ A /_\ A (:v)
8 O 4 5
Real
= @G A A /
® O 4 i [~

Calculates the implicit equation for the selected circle or a line.

Geometry Expressions will also attempt to calculate the equation of a locus
or envelope curve.

1.Select k any geometry object described above.

2.Click the Implicit Equation tool in the Calculate toolbox or select
Implicit Equation from the Calculate menu.

The real or symbolic equation appears by the geometry.
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Output

X

Math

Grid, Axis, Page

Angle Mode

Intermediate Variable Complexity (2 to 100)
Precision Type

Decimal Digits (0 to 8)

Output s

Use Assumptions

Use Intermediate Variables

Show Intermediate Variables

Show Name

Show System Variables

Maximum Size Allowed On Diagram

Viewing the Output

Radians
15
Significant Figures

8 Digits

SRR OO

119

The Output settings apply to Symbolic Calculations. The general default

Output settings are found in the Edit / Preferences menu selection,

X
1

Math tab Math

Individual outputs can be adjusted in the Display Properties dialog.

Select the output(s), then invoke the dialog in one of two ways:

e right click the mouse and select All Properties from the Selection

context me

nu
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Cut
2, 2
- \/a +c-2 .a c cos(a\ Copy
2-sin(B) Copy As >

/

D

Send to Mathematica

Paste

Delete

Hide Ctrl+H

Arrange >

—

= \/32.,.02_2.3.0.003(9) Convert to Real

Convert to Constraint (Input)

Line Properties >
Output Properties >
Show Symbol >
Text Properties >
All Properties... S

e from the menu bar, select Edit / Properties

Display Properties X
Decimal Digits (0 to 8) 8 Digits .
=/ Qutput
Use Assumptions ]

Use Intermediate Variables |:|
Show Intermediate Variables
Show Name

Show On Diagram

Show In Output Window I:l

Too Big for Diagram I:l

The Output selections specify how the calculations are made and how the
output is displayed.

Use Assumptions - applies to equations containing absolute values.

Use Intermediate Variables - can sometimes simplify the output.

The "Show" check boxes control where the output is displayed.
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The check boxes are toggles; when the box is checked the property is set to
true, when it is clear the property is false.

Assumptions

With the Use Assumptions selection, Geometry Expressions eliminates the
absolute value from expressions and determines from the diagram whether
the value is positive or negative. Try it with these steps:

1.select I} one or more output calculations

2.right click the mouse and select All Properties from the Selection
context menu

3.check the Use Assumptions check box

Obviously, this tool only has an effect when the expression selected
contains an absolute value.

Intermediate Variables

Substituting intermediate variables can sometimes simplify expressions
calculated by the program. Try this option to see how it affects your output:
1.select I} one or more output calculations

2.right click the mouse and select All Properties from the Selection
context menu

3.check the Use Intermediate Variables check box

If Use Intermediate Variables is False (uncheck), the Show Intermediate
Variables is inactive.

Note: Intermediate variables are not always used in calculations, in which
case this box will have no effect.
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Show Output Check Boxes

Display Properties X
Decimal Digits (0 to 8) 8 Digits .
=/ Qutput
Use Assumptions ]

Use Intermediate Variables |:|

Show Intermediate Variables

Show Name
Show On Diagram

Show In Output Window I:l

Too Big for Diagram I:l

After you generate an output expression:
1.click the output

2.right click the mouse and select All Properties from the Selection
context menu

3.when checked, the corresponding output is displayed

Show Intermediate Variables - if the system uses intermediate
variables, their definitions are displayed in the output window.

Show Name - is a term assigned by the system to the output. This name
is z, where n is the sequential number of the output .
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(=] Qutput
Use Assumptions ]
Use Intermediate Variables |:|

Show Intermediate Variables [/]

Show On Diagram
Show In Output Window [ ]

Too Big for Diagram ]

(-] Output
Use Assumptions |:|
Use Intermediate Variables |:|

Show Intermediate Variables

Show In Output Window

Show On Diagram
[]
[]

Too Big for Diagram

= \Ja%+b%-2-a-b-cos(8)

123

You can change the output name by double clicking the output and entering
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a new name in the box.

Length|

Length1= \/a2+b2-2-a-b-co (®)

Show On Diagram - puts the output expression on the diagram when the
box is checked.

Show in Output Window - puts the output expression in the Output
Window when the box is checked. If this box is checked, then Show Name
box is also checked.

Too Big for Diagram - the output expression is moved to the output
window when the box is checked (Show in Output Window is also checked
and Show On Diagram box will be unchecked).

Symbols
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Using Math Operations

@ E
2 @ WHEL
UG O @
The bottom row of buttons in the toolbox lets you insert commonly used

math operations. You can either use the icons, or your type them from your
keyboard:

Symbol Function Call / Reserved Word

Icon

| sqrt(value)

abs(value)

{88 piecewise({expression1, domaini1},{
expression2,domain2}...,{last expression,
otherwise})

pi

A complete list of built-in functions is detailed below.

Built-In Functions

For including in any expression or constraint, Gx has the following common
functions available:

Trig

e sin() e arcsin() e sinh()
e cos() e arccos() e cosh()
e tan() e arctan() e tanh()
Math
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®sqrt() - same as @ e abs() - same as
e signum(x) - finds the sign of a e exp(x) - the exponential function;
number: you must use exp, not e, e is just a
=-1ifx <0 variable name
Oifx=20
1ifx>0
e log() or In() - both mean the e piecewise({expressionl,
natural log domainl},{expression2,

domain2}...) - the function is
evaluated in the order written

e diff(expression, variable) e integrate(expression, variable)
e sum(expression, variable = start, |, i - same as U in the Symbols
end) toolbox
e ceil() - rounds up e floor() - rounds down
Boolean
AND <
OR <=
NOT >
>=

Multiplication & Division Editing Tools

aThe Multiplication button inserts a multiplication symbol into the

expression.

The Division button makes expressions easier to enter and read.

e From the data entry box, enter the numerator of the expression, highlight
it, and then click Division.

A2 XHX+Y |:> 2 X+

X+y

The cursor is then positioned in the denominator.
e If you click the Division button first, be sure to place the cursor in the
appropriate place before typing the expression.
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Square Root Editing Tool

@ You can enter square roots in one of these ways:
e From the data entry box, enter the expression you want inside the square
root, highlight the terms, and click the Square Root button.

e From the data entry box, click the Square Root button, then highlight
the 0 and type the terms.
e Use the sgrt() function in the data entry box.

I I I

Subscript / Superscript Editor

You can enter superscripts or subscripts for variables in one of these ways:
e From the data entry box, enter the expression you want sub/

superscripted, highlight the terms and click the Subscript or
Superscript o’ button.

A XHX+Y |:> 2 x(x+yj

e From the data entry box, click the Sub/Superscript button and type the
values into the grey boxes.

A xxH

Note: Make sure the cursor is positioned at the left side of the gray box
before typing the sub/superscript.
e Another way to make a subscript is to use square brackets - A[1] = Aq

Parentheses and Absolute Value Notation

You can add parentheses or an absolute value sign to a term in one of two

ways:
e From the data input box, type the term(s), highlight the term(s), then
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click the Parentheses or Absolute Value button.

2 XX+ > 2 xi(x+y )

e From the data entry box, click the Parentheses or Absolute Value
button first and enter the terms.

Using the Piecewise Function

A piecewise function or expression can be created using the Piecewise
symbol or the built-in function - piecewise({expression1, domainl},
{expression2,domain2}...,{last expression, otherwise}). The reserved
word, "otherwise" is an option available for the last condition.

For details see Piecewise Function and Piecewise Parametric Example in the
Creating Functions section.

Using Annotation Symbols

@ E

2 DRGRENS

0GE @ (=)
The top two rows of buttons in the Symbols toolbox are available for use
with any of the Annotate tools. These symbols are not used in Geometry

Expressions' algebra engine, but may be useful in creating worksheets and
tests.

Use the symbols from the data entry window of the Annotate tools.
Simply click the symbol you need as you type.
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When you are finished with the annotation, press enter.

129
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@ Font trouble - some of the Annotation Symbols may not show up in
your drawing, depending on your OS and the default font setting.
(Windows 7 users have no worries.) If you don't see an Annotation
Symbol, change the Edit / Preferences / Math / Annotation / Font /
Face Name. Try one of the Unicode fonts, e.g. Lucida Sans Unicode. If you
are exporting a Metafile, you may have to change the default font in the
program to which you are exporting.

Inserting Greek Letters

Lowercase

LEUEEAMNMO
UHOHMEME
UEHUHMMWE
WEOUEEEE)
UHAMHMNEEM
CEOMEMNGE

The Greek toolbox lets you easily insert Greek letters into your expressions
and constraints.

To insert Greek letters into a variable name or expression, select the
appropriate button from the Uppercase (Greek Capital) or Lowercase
(Greek Small) sections in the Greek Toolbox. This will insert the desired
letters into the entry window.
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entry highlighted

o

click the symbol
press the enter key

131

You can also type the name of the Greek letter into your expression, e.g
theta. The symbol will be inserted after you press enter. To get an
uppercase Greek symbol, capitalize the first letter of it's name, e.g. Theta.

System Variables and Animation

Variables

Name Value Locked
a 7.2710814 -

b 10.452015 -

x[0] 1.7222222 -

X[1] 5.8222466 -

y[0] 31944444 -

y[1] -1.4844995 -

0 130.97391 =

8 | 130.97391
KrPriumrM —
0.0 G4 2 360
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Investigating Variables

The Variables toolbox reports all the variables you have used in the
diagram and lets you manipulate their values.

@ Geometry Expressions - ] X
File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help
=] / A= > .
DR Heaéd YXDads ko aQ@mEAR D %%
iabl
OAnimation?gx X R
Name Value Locked
N " la 72710814
b 10.452015
Select ) x[0] 17222222
\\ - x[1] 5.8222466
- y[0] -3.1944444
Draw y[1] -1.4844995
L) 130.97391
Annotate
<] 130.97391 -
Constrain K> BN —
o OENE
4 % 360
v Functions
Calculate Name  Value
Symbols
Greek
v
< > ‘
Ready Selecting  (1.68442,-1.54344) Degrees v

© 2025 Saltire Software




Tools 133

Variables List

Variables

Name Value Locked
a 7.2710814

b 10.452015

X[0] 17222222

X[1] 5.8222466

y[0] -3.1944444

y[1] -1.4844995

(5] 130.97391

) | 130.97391 >
MPHEBEBIM —

0.0 'ONEEES

This list contains the names of all variables used in your diagram.

For every variable name, the system shows:

e the current value - these values can be ones that you have explicitly
specified, or just taken from the way you sketched the geometry.

e lock status - if the variable is locked (+) its value will not change if you

move the geometry or add additional constraints; the unlocked (-)
variable is free to change as the geometry moves or changes.

Functions List

When using the Function command to draw a function of the form Y=f(X)+g
(X), the Functions tab in the Variables toolbox lists the functions fand g
and their values. Use the edit line at the bottom of the box to modify the
functions.
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N Y =f(X)+g(X) Functions
Name Value
3 f XA[u] +f[v] + (f[b] +((X-f[a]) * (2))/(4...
9 X-g[ul+g[v]+(-g[b]-((X-g[a]) " (2)...
2
fU gu
1
N\
N
6 5 -4 3 2 -1 \}/2 3 4
1 3
-2
Edit Window
-3
v
> < X-g[u]+g[v]+(—g[b]—((X—g[a])’\(2))/(4))-exp‘
N 7

A
selecting (4.775,5.45833) Degrees v \_’/

Using the Lock Tool

By default, when you drag points in a Geometry Expressions model, it will
adjust the numerical sample values used in the various parameters of the
model to accommodate the drag, as best it can.

For example, in the model of a 4 bar linkage below, dragging point B will
cause lengths a and b and angle 0 to be adjusted appropriately.

[ X0-Yo )

However, you may want the drag to act as if the members AB and BC were
rigid, and only angle theta adjustable. To do this you can lock the
parameters:
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Variables

Name Value Locked
a 2.5 +

b 3.1509052  +

c 3.7384391

X[0] -1.0654206

x[1] 49305556

y[0] 0.19444444

y[1] 0.23611111

0 64.238768

a 25
KrPbHEMN —
1.8081712 @ 4 7.2326847

The value of a, for example, can still be set from the Variables panel, but it
will not change when the model is dragged.

Changing and Locking the Variable Value

Me 13097391 | 2 “

To make a change to the variable list, first click anyplace in the row of the
variable you want to change. That row will be highlighted.

To change the value: highlight the value in the edit window and type the
new value.

To change the lock status: just click the button -
mn .
to unlock a locked variable

b | .
to lock an open variable

Animation

Your geometry comes to life with the Animation tools. You simply need to
select the parameter that drives the animation, give it a range, then Play.

In the diagram below we select 0 for the crank of this linkage.
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() Geometry Expressions

File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help

W

=

0 Animation1.gx X

N

Select
Draw

v

Annotate

v

Constrain

v

Construct

v

Calculate

O .

Symbols

© .

Greek

<

Ready

Selecting

O 4 bar.gx

(12.3417,7.14772)

Degrees

=& XDaFdo i o

v

- ] X
3 m
= O 8 %
ariables
Name Value Locked
" a 7.2710814
b 10.452015
x[0] 1.7222222
x[1] 5.8222466
y[0] -3.1944444
yi1] -1.4844995
CEN 130.97391
|Variable list
o - [130.97391 2

Krunmram —

v
W ew

Functions

Name Value

Click the headings below for details on the animation buttons and windows:

e Animation console - works like a video player.

e Animation modes - indicates how the range for the animation is stepped

through.
e Animation values and duration - where you specify the speed and the

range for the driving parameter.

Users of numeric interactive geometry systems may be familiar with the
concept of animation based on points animated along line segments or
curves. This type of animation can be conveniently modeled in Geometry
Expressions using the point proportional along a curve constraint along

with parameter based animation.
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Animation Console

R 100 [ The Animation console works like a standard video console
with the Play, Pause, and Stop buttons as well as advance to the
Beginning and End buttons.

Animation Modes

-

—
The animation modes can be changed with the up/down arrow

buttons. The modes are:
— Runs the animation one time through the specified range.

= Runs the animation continuously from the beginning to the end of

the range.

< Runs the animation one time forward and then backward through the
specified range.

€2 Runs the animation continuously forward and then backward through
the specified range.

Animation Values and Duration

N
0.0 @E =1 360

These animation buttons help you adjust the range ahd speed of the
animation.

e Click and drag the slider along the bar to manually animate the drawing.

e In the two data entry windows at the bottom right and left of the toolbox,
specify the range of the animation.

e The Duration box in the center lets you specify how long the animation
takes to play one time through. Values are between 1 and 60 seconds.
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Animation and the Locus Tool

Both the construction of the locus and envelope curves, and the animation
of the diagram in Geometry Expressions can be defined in terms of any
variable. For example in the model below, we can create a locus over
values of the variable t (other variables will be kept constant).

(@) Geometry Expressions — ] X
File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help
—| = / - @ . -
DaHa&aéd xXDads ke Qe @HERQ # B
iabl
OAnimation'].gx OOvalofCassiniAgx X ariables
Name Value Locked
" la 4.0208333
k 17.83005
t 3.6742813
t | 3.6742813 n

KrunmEn —

L
[0 JOLHE[ ]

Functions

Name Value

< >

Ready Selecting (3.34438,-2.99977) Degrees ~
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Many of the menus and icons across the top of the screen duplicate the
commands and functions found in the toolboxes.

File Menu

The File menu contains the standard Windows file handling operations with
options for copying and exporting to other programs. Several of the options
are also available from the icon bar.

Menu Option

D New

New Graph
m Open. . .

Close

F-l Save

Save As . ..
Open Workbook

Save Workbook

Save Workbook as

Close Workbook

Import Figure from

Function
Creates a new project.

Graph mode allows scaling of axes.

Brings up the Select a File dialog box so you can
open a project.

Closes the current file or, if multiple files are open,
the file on top.

Saves the file. If you have not yet saved the current
work to a file, the Save File As dialog box lets you
specify where to save the project file.

Brings up the Save File As dialog box to enter a
new or different path / file name. Useful for making
a backup.

Brings up the Open Workbook dialog box. If any
other files are open, they will be closed when you
select the workbook.

Saves all tabbed pages as a single workspace (.
gXw), so you can open them all at once.

Saves all tabbed pages as a single workbook (.gxw)
and lets you specify a new or different path / file
name for the workbook.

Closes the current workbook. If you have made
changes to pages, you will be asked if you want to
save them individually (.gx files).

A shortcut containing common geometry figures that

© 2025 Saltire Software



Menus and lcons 141

Figure Gallery you may need for creating worksheets or other
documents.
Export Export the file as Windows Metafile (.emf) (

Windows version only), image file, an
Encapsulated PostScript (.eps), HTML file (.html),
animated gif, JavaScript file, Lua app, or OS X
Dashboard Widget.

Page Setup. . . Displays the page setup dialog box for choosing a
printer and print options.

€3 Print Preview Displays the printout by pages.

&= Print. . | Displays the standard system Print dialog.

Recent files Click to display a list of the most recently used files.
Selecting one opens it.

Exit Exits the program, after prompting for save.

Importing Files from the Figure Gallery

Are there figures which you need to use frequently? The Figure Gallery
makes your tasks easier. Browse through the folders to see the many
objects, graphs and transformation examples which you can use and tailor
to your needs without starting from scratch.

Figure Gallery database file is copied to your computer when you install
Geometry Expressions.

Here are the steps to import a figure:

1. Select File / Import Figure from Figure Gallery

2. Double click a folder or sub-folder (or click and press Select in the lower

right corner) to view of the problems in a category. You can also use the
search window to find files.
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Import a Figure

© A& o |

Go Home > Solids

7

Cone

A
/N
£ =

Hemisphere

Triangular Prism

[N

S ¥V

Cancel

Select

3. Double click a problem (or click and press Select) to see an enlarged

view

4, Click the Import button (it replaces the Select button in the lower right
corner) to bring the drawing into your drawing window.

Use the Toggle Hidden function from the general context menu to modify

constraints in the drawing, or try dragging the geometry to suit your needs.
Don't forget to Save.
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Navigating the Figure Gallery
The Figure Gallery is arranged in the usual tree structure containing
folders and sub-folders.
Import a Figure X
© & Go i > G
Cone Cube
Hemisphere Pyramid
—
Triangular Prism

Cancel

Select

@ Back - takes you up one level.

6\ Home - takes you to the top level.

Use the Search window to find a specific file or types of files. Enter the

search word(s) and click Go.

Text at the top center of the dialog tells you which level is displayed. Click

Home to return to the top level.
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Exporting a Drawing

(& Geometry Expressions

New
New Graph
Open...

Close

Save

Save As...

Open Workbook...
Save Workbook
Save Workbook As...
Close Workbook
Import Figure from Figure Gallery
Export

Page Setup...

Print Preview

Print...

Recent Files

Exit

File Edit View Draw Annctate Constrain (Input) Construct Calculate (Output) Help

Ctrl+N
Ctrl+G
Ctrl+O
Ctrl+W

Ctrl+S

Ctrl+P

i

lval of Cassini.gx

9 0 Q

Image File

Encapsulated PostScript (.eps)
Windows Enhanced Metafile (.emf)
Scalable Vector Graphics (.svg)
HTML (.html)

Animation

HTMLS5 / JavaScript App

Lua App

OS X Dashboard Widget

To export your drawing to another program, choose File / Export. You can
export the drawing in the following formats:

Static File Formats

o Image - BMP, JPEG, TIFF, PNG, XMP

e Encapsulated Postscript

e Windows Enhanced Metafile
e Scalable Vector Graphics

e HTML

Dynamic File Formats
e Animated GIF
e HTML5 / JavaScript App

o Lua App
e OS X Dashboard Widget

@ Please note that neither EMF, nor EPS support semi-transparency or
transparent images of any kind, thus you will get a warning message if you
try to export to either of these formats and you have such an item in the

document.

Here are the steps for the export as an Image file, EPS, EMF, SVG or HTML.:
1. For all file types enter the Filename or click the folder icon to select the

appropriate folder and file.

© 2025 Saltire Software



Menus and lcons

145

2. Image files and HTML files have an extra step at this point as detailed

below.

3. Select the region of the drawing with the displayed cursor ﬁ (click-

and-drag opposite corners of the region).

Animation Files and JavaScript Files have a few more details to consider as

explained below.

Exporting Image Files

When exporting image files, click the down arrow in the Save as type
to select your desired image format.

line

File name: ‘ Conics

Save as type: |BMP file (*.bmp)
BMP file (*.omp)

JPEG file (*,jpg)
TIFF file (* tif)

A Hide Folders PNG file (*.png)
XPM file (*xpm)

Next, set the resolution in the File DPI box. Click the down arrow and
select the appropriate setting or enter a humber in the window.

Image Export X

File Path: C:\GeometryExpressions\Conics.bmp

File Type: BMP file (*.bmp)
File DPI: | 150 v

OK Cancel

Exporting HTML Files

When you select File / Export / HTML, the HTML Export dialog appears.

Fill in the Html Export Settings with optional Title, Header and Footer text.
The Qutputs can be renamed to something less obscure than letters with
subscripts. You can give them actual labels using real words. You can also

display your output expressions in many popular CAS input formats
including Content and Presentation MathML.
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Html Export

(=] Html Export Settings
Output Directory
File Name
Webpage Title
Webpage Header Text
Webpage Footer Text
(-] Outputs
=l z[0]
Show in Export

Label

(-] Expression Output Forms

Display Derive input
Display Maple input

Display MathML input

C:\GeometryExpressions
area.html

Area between the arches

Calculus 4 Class

Area

Display Mathematica input

Html Export Settings
Output Directory
File Name
Webpage Title
Webpage Header Text
Webpage Footer Text
Outputs
z[0]

Show in Export

Label

C:\GeometryExpressions
area.html

Area between the arches

Calculus 4 Class

Area
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Exporting Animation Files

Select File / Export / Animation File to produce an animated gif. This
format is supported by many applications and will enable you to embed
animations in, for example, PowerPoint slides and Wikipedia pages.

Select the directory and file name of your gif, and you will be presented
with a dialog to choose the parameter on which the animation is based,
along with various technical aspects of the animation.

Animation Export X
File Path: C\GeometryExpressions\reflection.gif Browse...
File Type: Animated GIF
File DPI: ‘ Use screen DPI ~
Frames Per Second: |10
Number of iterations: | 0 > Enter "0" for unlimited iterations.
Variable: i
OK Cancel

File DPI - specify the resolution of the output. The higher number you use,
the slower will be the process of creating and loading the animation.

Frames Per Second - if you multiply this number by the animation
duration specified in the Variables toolbox, you will get the humber of
frames captured. For example if you are set at 10 frames per second, and
the Variables toolbox specifies the duration of the animation to be 4
seconds, then 40 frames will be captured. The more frames you capture,
the slower will be the animation creation process, and the longer the
animation will take to load.

Number of iterations - when an animation is played (e.g. when a
PowerPoint slide containing the animation is displayed), enter a number to
play the animation a specific number of times, or enter 0 to play it
continuously.

Variable - choose the variable that controls the animation. (All the
variables in the Variables toolbox should be available). The limits of the
variable defining the range of the animation should be set in the Variables
toolbox.

Exporting JavaScript Files

Select File / Export / [HTML5 / JavaScript App] - to export a
Geometry Expressions model as a JavaScript application (.html file), within
an html page. This can then run within any web browser that supports
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HTML 5.

Fill out the details in the JavaScript Applet Generator dialog.

JavaScript Applet Generator

(=] Applet Settings
Applet Name
Auto-scale
Width
Height
Webpage Title
Webpage Header Text
Webpage Footer Text
CSS file (optional)
Additional JS file (optional)
(-] Inputs
- a
Show in Export
Label
Ul Type

=lb
Show in Export
Label
Ul Type

c

[-] Qutputs

[=J'r

Show in Export
Label

Ul Type

X

(C:\GeometryExpressions

Incircle

350

350

Incircle radius

What lengths make the radius an integer?

What if the triangle is <b> Pythagorean </b:

side BC

Text Box

side AC

Text Box

radius

Plain Text

Cancel
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Output directory - tells Gx where to put the files. It will create a file:
name.html in the specified directory. You should be able to bring
name.htm/ up in a browser to see the applet.

Applet Name - is the name of the html file.

Auto-scale - when checked, the JavaScript applet automatically rescales the
drawing when the user changes the value of one of the inputs; when
unchecked, you click-and-drag a rectangle around the drawing after you
click Ok.

Width and Height specify the size of the drawing on the html page.

Webpage Title, Webpage Header Text, and Webpage Footer Text - enter
your text for these sections of the applet.

Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:
e select the text entry box

e click the | ~ | to display the dialog
e enter or edit text, then click Ok.

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

Webpage Footer Text X

What if the triangle is <b> Pythagorean </b>?

OK Cancel

Inputs - lets you choose which variables the user will be able to change,
what text Label identifies variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the
JavaScript model. See the topic detailing UI Types below.

Outputs - lets you choose which outputs will appear in the applet, and their
text Label.

See the examples below.
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JavaScript Applet Example

We'll use this Gx model, displaying the radius of an incircle to create a
JavaScript Applet.
B

Ja+b-c-/a-b+c--a+b+c

2-/atbh+c

Here are the parameters we entered in the JavaScript Applet Generator
dialog:
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JavaScript Applet Generator X

[-/ Applet Settings

Qutput Directory C:\GeometryExpressions

Applet Name Incircle
Auto-scale

Width 350

Height 350
Webpage Title Incircle radius

Webpage Header Text What lengths make the radius an integer?
Webpage Footer Text What if the triangle is <b> Pythagorean </b:
CSS file (optional)

Additional JS file (optional)

(= Inputs

= E]
Show in Export
Label side BC
Ul Type Text Box

-lb
Show in Export
Label side AC
Ul Type Text Box

C

[-] Outputs

=lr
Show in Export
Label radius
Ul Type Plain Text

Here is the result:
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Incircle radius

What lengths make the radius an integer?

A
side BC |6 I
side AC |8 I
side AB I 10 I
radius 2.0000000

What if the triangle is Pythagorean ?

App generated by Geometry Expressions

The exported image can be zoomed in and out using the - and + keys on
the keyboard or paned around using the arrow keys. If displayed on a
touch sensitive device, the app supports multi-touch features.

JavaScript Animated Applet

In this applet, we'll draw a general function, f(x) and then create its
derivative at t (using the Point proportional .':.!-constraint). Here is the Gx

drawing:
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ariables
Name Value Locked
t 5.02
t 502 2
Y=f(t)+(X-t)-F(t) <Kr>umrMm —
| B :

Here are the parameters we entered in the JavaScript Applet Generator
dialog:
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JavaScript Applet Generator X

(-] Applet Settings

Qutput Directory C:\GeometryExpressions\

Applet Name derivative

Auto-scale

Width 400

Height 400

Webpage Title The derivative of a Function at Point t

Webpage Header Text
Webpage Footer Text Now modify the function.
CSS file (optional)

Additional JS file (optional)

(= Inputs
B
Show in Export
Label t
S e
(=l
Show in Export
Label f(x)
Ul Type Text Box

Selecting slider for the UI Type of variable t we now have the Go/Stop
button to control the animation of t between the ranges defined in the
Variables panel above.
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The Derivative of a Function at Point t

t — ]
2.51 4.9973874 10.04
£(x) ((1.07728761579377*x)+(-5.345676448986

Now modify the function

App generated by Geometry Expressions
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The Derivative of a Function at Point t

A Y=f(t)+(X2)-F(t)

f(x)

A

To modify the function, simply type a new one in the edit field. A multi-line
function allows more options.

Creating Lua Applets

If you have a TI-Nspire™ calculator, you can put your Geometry

Expressions model on it by creating an interactive Lua app.

Variables can be adjusted from a text box or with a slider. Any points in
the Geometry Expressions model constrained by variable Coordinates or a
variable parameter for the Point Proportional constraint can be set as
draggable points in the Lua app.

After you create your Gx model select File / Export /Lua App. Fill out

the details in the Lua App Generator dialog.
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Lua App Generator

(-1 Applet Settings
Output Directory
Applet Name
Auto-scale

-] Inputs

=] t

Show in Expor

Label

=i
Show in Expor
Label

Ul Type

C:\GeometryExpressions

Derivative

t

Draggable
Slider
Text Box

Advance Button

157

Media Controls v

Cancel

Output directory - tells Gx where to put the file. It will create a file:
name.tns in the specified directory.

Applet Name - is the name of the Lua (.tns) file.

Auto-scale - when checked, the Lua applet automatically rescales the
drawing when the user changes the value of one of the inputs; when
unchecked, you are prompted to click-and-drag a rectangle around the
drawing after you click Ok.

Inputs - lets you choose which variables the user will be able to change,
what text is displayed for the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the
Lua app. See the topic detailing UI Types below.

Outputs - lets you choose which outputs will appear in the applet, and their
text Label.

Any measurements which are present in the Geometry Expressions model
may be chosen as outputs for the Lua app.
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When you click OK, the Lua code is placed on the clipboard (and also in the
file you specified), ready to paste into your TI-Nspire Teacher Software

Script Editor.

Tl Lua Script Editor

To make a Lua app for your TI-Nspire™, you must have the TI-
Nspire™ Teacher Software or TI-Nspire™ CAS Teacher Software

installed.

Click Insert / Script Editor / Insert Script to display the Script Editor

window.

< luaex - Tl-Nspire™ CAS Teacher Softw]
File Edit View Ingert Tools Window

Content Documents.

9 - s B

Documents Toolbox
i * m 7 o =

oi[% Math Templates

11 Setings

xxxxxx

Oocumentview ] & | Zoom: [150% -] - +

Paste (ctr/-V) your clipboard contents into the window. Click Set Script.

The exported image lets you zoom in and out using - and + keys on the

keyboard or pan the image using the arrow keys.
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Creating OS X Dashboard Widgets

Dashboard Widgets are very similar to JavaScript Applets, but they sit on
The Mac Dashboard. Select File / Export /OS X Dashboard Widgets.

Fill out the details in the OS X Dashboard Widget Generator dialog.

OS X Dashboard Widget Generator X

Widget Title ~

Widget Header Text
Widget Footer Text
CSS file (optional)

Additional JS file (optional)

(= Inputs
[—]|t
Show in Export
Label t
=]|f Draggable ~
Label Text Box
Ul Type Advance Button
Media Controls I
oK Cancel

Output directory - tells Gx where to put the files. It will create a folder:
name.wdgt containing all the components of the widget.

Widget Name - is the name of the folder and the main .html file.

Auto-scale - when checked, the Widget automatically rescales the drawing
when the user changes the value of one of the inputs; when unchecked,
you click-and-drag a rectangle around the drawing after you click Ok.

Width and Height specify the size of the drawing in the Widget box.

Widget Title, Widget Header Text, and Widget Footer Text - enter your text
for these sections.

Since header and footer text may be several lines long, You can go back
and change these text boxes before you close the dialog:
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e select the text entry box

e click the | " | to display the dialog
e enter or edit text, then click Ok.

Note: you can insert html code into the header and footer text, e.g. to
make a word in the footer text bold:

Webpage Footer Text X

The crank is driven by the parameter <b>t</b>; point
<b>B</b> is proportional about the unit circle.|

CSS file (optional) - you can attach your favorite Cascading Style Sheet,
without having to reproduce it every time.

Inputs - lets you choose which variables the user will be able to change,
what text Label identifies the variable and what type of control to use.

Any variables in your Gx model may be selected as input variables in the
Widget. See the topic detailing UI Types below.

Outputs - lets you choose which outputs will appear in the applet, and their
text Label.

Any measurements which are present in the Geometry Expressions model
may be chosen as outputs for the widget.

Ul Types for Applets

JavaScript, Lua Apps and Widgets use identical Input and Output types.
Here are the selections.

Inputs
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JavaScript Applet Generator X
(= Inputs ~
=la
Show in Export
Label a
Ul Type Text Box
=k
Show in Export
Label k
=l|n
Show in Export Slider
Label Text Box
Ul Type Advance Button
=]t Media Controls v
Show in Export
Label t
Ul Type Text Box

Cancel

Draggable - any points in the Geometry Expressions model constrained by
variable Coordinates or a variable parameter for the Point Proportional
constraint can be set as Draggable points in the JavaScript, Lua app or
Widget. The point's constraint variables, however, cannot be functions or
negative; only positive variables are allowed for defining draggable points.
I.e., the value of the variable may very well be negative, but using -t as the
point proportional parameter or (x, 3*x) as a point's coordinates prevents
the point from being draggable.

Slider - takes it's range from the values specified in the Gx Animation in

the Variables panel. @ Please note - not all browsers support sliders.

Text Box - lets you enter any numeric value for the variable.

For a function, you have the choice of a single line Text Box or a Multiline
Text Box. Remember to use the JavaScript return statement in multi-line
statements in JavaScript Apps or Widgets.

© 2025 Saltire Software



162

Geometry Expressions Manual

JavaScript Applet Generator

(= Inputs
a
n
B
Show in Export
Label
Ul Type
]| f
Show in Export

Label

-9
Show in Export
Label

Ul Tvoe

t

Text Box

f(x)

Ul Type Text Box

Multiline Text Box

OK Cancel

@ Note: when defining variables or functions in the edit field of JavaScript
Apps or Widgets, remember that JavaScript does not use "N" to denote a

power. X* must be written: pow(X,2).

Advance Button - displays the variable Label on a button and increments
the variable when clicked. Uses the range and direction from the GX
animation settings. If you used decimal values in GX, the values are
reduced to integers.

Media Controls - works like the Advance Button but gives you some
additional options. For values within the specified range, you can:

1. increment or decrement regardless of the mode setting

2. jump to a specific integer value by typing (as in the Text Box mode)

3. jump to the beginning or end of the range
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RN RENONESE 3
e N

Timer - this is great for making Clock Applets and smooth animations.
Here are the Timer Styles:

Ul Type Timer
Animation period, continuous
(=l f Animation period, continuous ~

Show in Export 1 minute period, continuous
Label 1 minute period in 1 second increments
Ul Type 1 hour period, continuous
=lg 1 hour period in 1 minute increments

The hour, minutes and seconds are taken from your computer's clock.
Random - gives the specified variable a single random value within the
range set in the Gx Variables tool panel. To change the variable's value to

another random number click the Reload button C .

Outputs

Any measurements which are present in the Geometry Expressions model
may be chosen as outputs for the JavaScript, Lua Apps or Widgets. Check
the Show in Export check box and modify the Label if needed.

(-] Outputs
=l z[0]
Show in Export
Label z[0]
=l z[2] Plain Text
Show in Export Show/Hide Button
Label z[2]
Ul Type Plain Text

UI Type - Plain Text or Show / Hide Button which is a toggle.
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Graphing Mode

When you need to draw a graph requiring independent scaling of the axes,
select File / New Graph.

e Draw your graph.
e Click an axis - the axis will be highlighted and a circular handle appears.

Y=a-sin(X)

TN\ 213 T3 w3 23 n\

i

&

e Slide the handle up and down the axis with your mouse.

1.5
Y=a-sin(X)
Y

1.0

0.5

-211/3 -T1/3 /3 21/3

-0.5

-1.0
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-41/3

5

- -21/3 -m1/3 3 2m/3 i 411/3

Note: Many of the geometry drawing, constraint and construction tools are
unavailable (grayed out) in the Graphing mode for obvious reasons related
to the independent scaling of the axes.

Edit Menu

The Edit menu contains the standard Windows editing operations as well as
ways of dealing with constraint conflicts and all of the program settings.
Several of the options are also available from the icon bar.

Menu Option

('J Undo
l'.') Redo

k Select

Select All

Select All Type

Clear Selection

c}{) Cut

@ Copy

Function

Reverses actions starting
with the last one.

Reinstates actions starting
with the last one that was
undone.

When checked, the select
mode is active.

Selects everything in the
drawing window.

Presents a submenu of
object types to select.

Unselects any objects that
are selected.

Deletes an object, but
saves it so it can be pasted
somewhere else.

Does not delete the object,
but saves is so it can be

When Available

After any action has been
taken.

After using Undo

Select mode is always
active except when using
a Drawing tool or moving
or panning the drawing.

Always

Always -- most useful
when the object type is in
the window.

Always

An object is selected

An object is selected
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Copy As

@ Copy Drawing

0 Copy Region

(=)
.E Paste

Delete

Arrange

Send to
Mathematica

Convert to
Constraint

Convert to
Measurement

Convert to Real

Convert to
Symbolic

pasted somewhere else.

Displays a submenu of
choices for copying
mathematics into other
programs.

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Copies a section of the
drawing window inside a
rectangle made by dragging
the cursor.

Puts whatever has been cut
or copied into the current
drawing

Deletes whatever is
selected, without saving it.

For placing selected objects
on top of (bring forward) or
underneath (send
backward) other objects for
easier selection and
viewing.

Inputs the math to
Mathematica when the
algebra system is running in
another window.

Tries to convert a selected
output [ = 260] to an input
constraint if there is no

conflict with other
constraints

Converts the selected
constraint into a
measurement (output)

Converts a symbolic
calculation to a real one

Converts a real calculation
to a symbolic one

An expression or formula
is selected

Always

Always

Object(s) cut or copied

One or more objects
selected

One or more objects
selected

Windows version only

An output expression or
formula is selected

An output expression is
selected

An input constraint is
selected

A symbolic output is
selected

A real output is selected
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Details. . . Displays the Edit Text dialog A block of text is selected
to edit a block of text

Parameters. . . Lets you edit the A function, locus or trace
parameters of functions, is selected
loci and traces.

Properties. . . Lets you edit the display One or more objects of
properties of the selected the same type are
object(s) selected

Preferences . . . Sets the default appearance Always

and properties for the
project's drawing, text and
mathematics

NOTE: For the Mac version, Preferences are found under the Geometry
Expressions menu.

Copying Mathematics

To copy expressions or functions into an Algebra system or another
program:

e Select the math from the Diagram or the Output window.
e Select Edit / Copy As or right-click the selected expression to display

the submenu of choices for copying expressions or functions from
Geometry Expressions to another program.
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@ Geometry Expressions - O X
File Edit View Draw Annotate Constrain (Input) Construct Calculate (Output) Help
Undo Move Geomet Ctrl+Z = i D o]
C o Yoo, @ e g e @ o @ SURE N
( e le radius).gx
| ™~ Select All Ctrl+A
Select All Type > "
Clear Selection ) . .
s circumcircle radius
= Cut Ctrl+X | abc
( Copy Ctrl+C [ a-brc[fatbrc S el el e el s
Copy As » > Content MathML
o Copy Drawing Presentation MathML
Copy Region TeX >
An Paste Ctrl+V Derive Input
Delete Delete Maple Input
Arrange > Mathematica Input
e Send to Mathematica Maxima Input o
Convert to Constraint MuPAD Input
_Col Convert to Measurement TI—Nspire Input
Convert to Real String
Convert to Symbolic Source Code
_Cal Details...
E Parameters...
Properties...
Sy
E Preferences...
Greek v
< >

e The 2 general types of MathML are available, Content and Presentation
MathML, as well as formats meeting the specific quirks of several popular
Computer Algebra programs.

e The TeX typesetting output gives you 3 choices in the submenu: Inline,
Display and Wikipedia. The actual TeX produced is identical, except for
the delimiters which mark the start and finish of the TeX code.

e There is also a general purpose String output which converts the selected
math into a text string containing no special characters:
a-h-c
=
Jasbtc-asb-cfabre-athrc s copied as > (((a)(2)+(b)(2)+(cos(8)
*b*a*(-2))))"(1/2).
e Generate Source Code from Geometry Expressions in a number of
different languages:
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ab-c
B = Jatbrc-atb-c-Ja-brc-latbrc

Cut

Copy

Copy As > Content MathML

\ Send to Mathematica Presentation MathML

Paste TeX >

Delete Derive Input

Hide Ctrl+H Maple Input

B Arrange > Mathematica Input

Convert to Real Maxima Input

Convert to Constraint (Input) MUPAD Input

Line Properties > TI-Nspire Input

Output Properties > String

Show Symbol > I Source Code % > C / Objective C

Text Properties > Ct+

All Properties... C#
Visual Basic (.Net)
VBA
Java
JavaScript
Python
ActionScript
Lua
Matlab

When you make a submenu selection, the selected math is copied to the
Windows clipboard, ready to be pasted into the appropriate application

(Ctrl+V).
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Generating Source Code

You can generate computer source code from Geometry Expressions in a
number of different languages.
abc
=
\Jatb+c-ja+b-c-Ja-b+c-[a+b+c
Cut

Copy
Copy As > Content MathML
Send to Mathematica Presentation MathML

B

A Paste TeX >
Delete Derive Input
Hide Ctrl+H Maple Input
Arrange > Mathematica Input
Convert to Real Maxima Input
Convert to Constraint (Input) MuPAD Input

Line Properties TI-Nspire Input

>
Output Properties > String
Show Symbol > | Source Code % > C / Objective C
Text Properties > Ct+
All Properties... C#
Visual Basic (.Net)
VBA
Java
JavaScript
Python

ActionScript
Lua
Matlab

There are two types of expression in Geometry Expressions:
e Scalar
e VVector

The source code will be in a different form depending on whether there are
intermediate variables present or not.

Note that there is not much difference between the languages in the
mathematical expressions they generate. The main differences are:

e C#, Java, Javascript, ActionScript, Visual Basic (.net), and Lua prefixes
math functions with *Math.”

e C/ C++, VBA, and Matlab do not use any prefix for the math functions
Each language has its own way of invoking functions. In the cases where a

vector is returned from the function, the different languages work in
different ways.

e In C pointers to doubles representing the x and y coordinates of the
vector are passed into the function.
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e In C++, Visual Basic and VBA, references to doubles representing the x
and y coordinates of the vector are passed into the function.

e In C# double out parameters for the x and y coordinates of the vector
are used.

e In Java, JavaScript and ActionScript, an array is passed into the function,
the Ot and 1st elements of the array will acquire the x and y coordinates
of the vector.

Source Code Examples

From the following example we'll copy the expressions for the location of
point D (a vector) and distance AD (a scalar) in our code generation.

B

\E-x/c2+c-(-a+b)
va+b+c

Distance—=

Location—= [

-(a-b-c) -Ja*tb-c~/a-b+c-|-a+b+c
2 7 2-Ja+b+c

Scalar / No Intermediate Variables

e Select the distance expression.

e Right-click and select Copy As / Source Code / C/Objective C

In this case the code generates a single expression (here we are generating
C):
(pow((pow(c,2)+((a+(b*-1))*c)),0.5)*pow((a+b+c),-0.5)*pow(a,0.5)).
Scalar / Intermediate Variables
With intermediate variables showing we get the following for the distance
expression:
double distance(

double a ,
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double b,
double c )

double d_1;

double v_1;

double phi_0;

double d_2;

double d_0;

double u_1;

d_1-=
(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.5)*
pow((a+b+c),0.5));

v_1 = (d_1*pow(a,-1)*0.5);

phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));

d_2 = (v_1*pow(b,-1)*a*-1);

d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));

u_1 = (d_O*pow(a,-1)*0.5);

return
(pow(fabs(phi_0),-1)*fabs(d_2)*pow((pow(c,2)+(u_1*c*2)+pow(u_1,2)+p
ow(v_1,2)),0.5)*pow(c,-1));
b

We see that the name of the function is the name of the expression in
Geometry Expressions, its parameters are the input variables, and its
return value is the value of the expression.

Vector / Intermediate Variables

Select the location expression, a vector value, and our function returns two
quantities. This is done in different ways for different languages:

C / Objective C
Pointers to doubles are passed into the function:
void location(

double a,

double b,

double ¢,

double *location_x_,

double *location_y_ )

double location_x;
double location_y;
double d_1;
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double v_1;

double d_2;

double d_0;

double u_1;

double phi_0;

d_1-=
(pow(((a*-1)+b+c),0.5)*pow((a+(b*-1)+c),0.5)*pow((a+b+(c*-1)),0.5)
*pow((a+b+c),0.5));

v_1 = (d_1*pow(a,-1)*0.5);

d_2 = (v_1*pow(b,-1)*a*-1);

d_0 = (pow(a,2)+(pow(b,2)*-1)+pow(c,2));

u_1 = (d_O*pow(a,-1)*0.5);

phi_0 = ((a+b+c)*v_1*pow(c,-1)*pow(b,-1));

location_x = (((d_2*-1)+(u_1*d_2*pow(c,-1)*-1))*pow(phi_0,-1));

location_y = (pow(phi_0,-1)*v_1*d_2*pow(c,-1)*-1);

*location_x_ = location_x;
*location_y_ = location_y;
b
C++

References are passed into the function:
void location(

double a ,

double b,

double c,

double &location_x_,

double &location_y_ )

{
double location_x;
double location_y;
location_x_ = location_x;
location_y_ = location_y;

b

C Sharp

Out parameters are passed into the function:
void location(

double a ,

double b,

double c,
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out double location_x_,
out double location_y_ )

{
double location_x;
double location_y;
location_x_ = location_x;
location_y_ = location_y;
¥

Visual Basic / VBA
References are passed into the function:
Sub z_0(ByVal a As Double , ByVal b As Double , ByVal c As Double , ByRef
z_0_x_ As Double ,ByRefz 0_y_ As Double )
Dim z_0_x As Double
Dim z_0_y As Double

z_O_y:

End Sub
Java

An array of doubles of size 2 is passed in and populated by the function:
double location(

double a,

double b,

double c,

double[] location_v )

{

double location(
double a,
double b,
double ¢,
double[] location_v )

double location_x = 0;
double location_y = 0;

location_v[0] = location_x;
location_v[1] = location_y;
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b

JavaScript

An array is passed in and populated by the function:
function location(

a,
b,
c,
location_v )
{
var location_x = 0;
var location_y = 0;
location_v[0] = location_x;
location_v[1] = location_y;
)

Action Script
An array is passed in and populated by the function:
public function location(

a:Number ,
b:Number ,
c:Number,
location_v:Array) )
:void
{
var location_x:Number;
var location_y:Number;
location_v[0] = location_x;
location_v[1] = location_y;
b
Matlab

You get native Matlab code which can be pasted into a function.

function [location_x ,location_y] = location(a ,b ,c)
v_1=(power(((a*(-1.0))+b+c),0.5)*power((a+(b*(-1.0))+c),0.5)*power((
a+b+(c*(-1.0))),0.5)*power((a+b+c),0.5)*power(a,(-1.0))*0.5);

location_x=(((c*(-1.0))+((power(a,2.0)+(power(b,2.0)*(-1.0))+power(c,
2.0))*power(a,(-1.0))*-0.5))*power(((a*(-1.0))+(b*(-1.0))+(c*(-1.0)))(
-1.0))*a);
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location_y=(power(((a*(-1.0))+(b*(-1.0))+(c*(-1.0))),(-1.0))*v_1*a*(-1.
0));

See Using Geometry Expressions with Matlab document in the Doc
subdirectory in your Gx installation for more details and examples.

View Menu

The table below lists the complete summary of View functions.

Menu Option Function When Available

Hide Hides a selection One or more elements

are selected.

Show all Displays any entities that One or more elements
were hidden are hidden.

N\ Toggle Hidden | Lets you toggle hidden / Always (if the drawing
visible for any object in the |window isn't empty)
drawing

Zoom In Makes the drawing details Always available - (most
larger without affecting the useful when there is
size on the printed page. something in the drawing
(The text gets larger on the window).
screen.)

Zoom Out Makes the drawing details Always available - (most
smaller without affecting the useful when there is
size on the printed page. something in the drawing
(The text gets smaller on the 'window).
screen.)

Zoom To Selection Lets you make a selection Always available - (most
and adjusts it to fit the useful when there is

drawing window. (The text something in the drawing
gets larger on the screen.) window).

Zoom To Fit The entire diagram is Always available - (most
displayed in the drawing useful when there is
window. (The text size something in the drawing
changes with the geometry.) 'window).

Zoom To Page The whole page is displayed |Always available - (most
in the drawing window. (The |useful when there is
text size changes with the something in the drawing
geometry.) window).

Allows you to move the Always available - either

= Pan View
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@,

& Scale
Geometry Up

Q

§ Scale
Geometry Down

Geometry To
Selection

A

-] Scale
Geometry To Fit

@ Scale

<

Geometry To Page

L—]Q Move
Geometry

% Axes
% Grid

Page Boundaries

Tools

Variables /

Functions

contents of the drawing
window without changing its
position on the page.

Enlarges only the geometry.
(The text size on the screen
doesn't change.)

Shrinks only the geometry.
(The text size on the screen
doesn't change.)

Lets you select a portion of
the geometry and adjusts it
to fit the drawing window
(The text size on the screen
doesn't change.)

Adjusts all geometry to fit in
the drawing window. (The
text size on the screen
doesn't change.)

Adjusts all geometry to fit
inside the specified page
boundaries. (The text size

doesn't change relative to the

page.)

When checked, click and drag
to move the drawing contents

with respect to the page
boundaries.

When checked, the axes are
displayed. They have the
properties of Infinite Lines.

When checked, the grid is
displayed.

When checked, the page
boundaries are displayed.

When checked, the Tools
panel is displayed on left side
of the screen.

When checked, Variables
and Functions toolboxes are
displayed on right side of the

Pan View or Move
Geometry will be in
effect (checked).

Always

Always

Always

Always

Always

Always. Make sure Page
Boundaries is checked
(below) to see the
results.

Always

Always
Always

Always

Always
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screen.
Output When checked, the output Always
window is displayed.
Language The current version of Always

Geometry Expressions can be
displayed in Chinese,
English, French, German,
Greek, Japanese, Korean,
Polish, Russian, or Spanish
. Choose one and restart the
program.

Checked menu options are toggles:
e Checked indicates the option / mode is active or displayed.

e Unchecked indicates the option / mode is inactive or hidden.

e Except Pan View and Move Geometry where one or the other is
checked.

Click the selection to change its state.

Some menu items have icon shortcuts found on the icon bar at the top of
the screen.

Zooming and Scaling

The View menu has Zoom operations pertaining to the screen view, and

Scale operations pertaining to the page view.

e Zooming makes the drawing details smaller without affecting the size on
the printed page. The text (constraints, output and annotation) changes
size with the rest of the drawing.

e Scaling adjusts the size of the geometry relative to the page, but the text
doesn't change size in the drawing window. Check View / Page
Boundaries to see this work.

The Scale functions used from the icon bar at the top of the screen can be
changed to Zoom functions by holding the ctrl key while clicking the icon.
This is handy if you need to change the size of the text on the screen:

@

e A Scale down ™ followed by a Zoom in [ctrl] ~s has the effect of
enlarging the text.
@

e A Zoom out [ctrl] @\ followed by a Scale up ~s has the effect of

shrinking the text on the screen.
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Toolbox Menus

The menus with the same name as the toolboxes at the side of the screen
just give another way of accessing the same functions.

Menu Option
Draw

Annotate

Constrain

Construct

Calculate

179

Infinite Line
Circle

Hyperbola

Curve
Approximation

Expression

Coefficients

Selection

Point Line Segment
Vector Polygon
Ellipse Parabola

Arc N-gon

Text Picture
Function

Angle Distance / Length
Coordinate Radius
Direction Slope
Distance / Length Radius
Angle Direction
Coordinate Coefficients
Incident Congruent
Equation Proportional
Midpoint Intersection

Angle Bisector

Parallel

Tangent to Curve

Polygon

Translation
Locus
Distance / Length

Rotation
Trace
Radius

Direction
Area

Parametric
Equation
Stop Calculations

Slope
Perimeter

Implicit Equation

Start Calculations

Expression

Perpendicular

Slope

Tangent
Parallel

Perpendicular
Bisector

Perpendicular
Reflection
Dilation

Area Under Arc
Angle
Coordinates
Coefficients
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Help Menu

The Help menu lets you access this help system, check for updates, change
the program's language, and gives you information about the program's
license and version.

The menu selections are always available.

Menu Option Function

Dynamic Help Invokes the Help system

Contents. . . Look in the Table of Contents; add new or refer to
saved bookmarks.

Index. . . Look in the Help index. There is also a facility to
Search index headings.

Search. . . Search the Help topics for keywords.

License. . . Displays information about your license.

Check for Updates. Prompts you to save your work, checks for new
versions of Geometry Expressions, then restarts the

program.

About. . . Contains the current version of the program, the
copyright notice, and the link to Geometry Expressions
website.

NOTE: For the Mac version, About... is listed under Geometry
Expressions menu.

Context Menus

Context Menus pop up when you right-click with the cursor positioned

anywhere in the drawing window.

e The general context menu - appears when you right click and nothing is
selected.

e The selection context menu - appears when one or more elements in the
drawing window are selected. Some menu entries my be inactive,
depending on which elements are selected.
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The General Context Menu

Right-click anywhere in the drawing window to display a context menu. If
nothing in the window is selected, the menu choices are the following:

Menu Option
Close
Save

Save As. ..

Select All

Select All Type

@Copy Drawing

(o Copy Region

(=)
.Ié Paste

Show All

N\ Toggle Hidden

3
o Stop
Calculations

‘ff Start

Calculations

Function
Closes the current file

Updates a file that already

exists

Saves a file for the first time
and prompt for the filename

and path

Selects everything in the
drawing window

Presents a submenu of object

types to select.

Copies everything in the
drawing window as an
Enhanced Metafile (.emf)

Copies a section of the drawing
window inside a rectangle made

by dragging the cursor.

Puts whatever has been cut or

copied into the current
document

Displays any entities that were

hidden

Lets you toggle hidden / visible
for any object in the drawing

Stop current calculations

When Available
Always
The file has been saved

Always

Always

Always -- most useful
when the object type is
in the window.

Always

Always

Object(s) cut or copied

One or more element(s)
are hidden

Always

A calculation isn't
finished

Restart any stopped calculations A calculation is stopped

by user
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Toggling - Hide / Show Elements

From the general context menu select Toggle Hidden. The magic wand
cursor appears, and any hidden objects appear faintly in the drawing
window and when your wand cursor is nearby or on top of an object, the
object will highlight in green. The displayed item will highlight in orange
when the wand is nearby or on top of the object.

Arbelos Arbelos

Click faint items to display them. Click any displayed items to hide them.
When you are finished toggling, click the select arrow W.

Selection Context Menu

Select one or more drawing elements and right-click anywhere in the
drawing window to display a context menu. Selection context menus
contain some subset of the following list.

Menu Option Function When Available
c}éCut Deletes an object, but saves it so One or more objects
it can be pasted somewhere else |selected
MY co Does not delete the object, but One or more objects
Py : .
saves is so it can be pasted selected
somewhere else
Copy As Displays a submenu of choices for /An expression or
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Send to
Mathematica

(=)
.E Paste

Delete
Hide

Edit Parameters...

Arrange

Constrain (Input)
Construct
Calculate (Output)

Visibility Condition

Point Properties

Arrow Heads

Arrow Size

copying mathematics into other
programs

Inputs the selected expression to
Mathematica when the algebra
system is running in another
window

Puts whatever has been cut or
copied into the current document

Deletes whatever is selected,
without saving it.

Makes the selected objects
invisible

Lets you edit the domain of a

formula is selected

An output
expression or
formula is selected

Object(s) cut or
copied

One or more objects
selected

One or more objects
selected

A function, locus, or

polar or parametric function or the trace is selected

parameters of a locus or trace.

For placing selected objects on top One or more objects

of (bring forward) or underneath

(send backward) other objects for

easier selection and viewing

Displays a submenu identical to
the one in the same drop-down
menu on the Menu Bar

Displays a submenu identical to
the one in the same drop-down
menu on the Menu Bar

Displays a submenu identical to
the one in the same drop-down
menu on the Menu Bar

Lets you enter an equation
specifying when the selected
object(s) are visible.

Lets you change the selected
point's color and size and enable
the Point Trace

Lets you turn off or change the
arrow head style of the selected
segment(s) or arc(s)

Lets you choose the size of the
arrowheads (when used)

selected

Geometry selected

Geometry selected

Geometry selected

One or more objects
selected

One or more points
selected

One or more line
segments or arcs
selected

One or more line
segments or arcs
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with arrowheads

selected
Line Properties Lets you change the selected One or more objects
line's color, style, and thickness created with lines or
segments
Fill Properties Lets you change the color, style, Polygon, N-gon,
and transparency level of the filled circle, filled
selected object(s) ellipse, picture or
trace selected
Pinned Lets you pin / unpin the selected Text, picture, or
object(s) expression selected
Text Properties Lets you change the selected Text, label,
text's color, size, and style expression,
constraint, or
measurement
selected
Show Symbol A toggle to display or hide the Constraints,
selected object(s) annotations, or
measurement lines
selected
Output Properties |Lets you turn on or off the One or more
selected output's name, outputs selected
assumption or intermediate
variables
Show Arrowheads | Lets you turn on or off the One or more angle
selected angle symbol's symbols selected
arrowheads

Congruence Style Lets you change the angle style One or more angle
from arcs to tics and vice versa or congruent angle
annotations selected

Tic / Arc Count Lets you change the number of One or more
tic/arc counts of selected congruent,
annotations congruent angle, or
parallel annotations
selected
AXis Arrow Lets you put arrowheads and / or |One or both axes
axis name labels on the selected | selected
axes
AXis Properties Lets you turn the labels or the One or both axes

arrowheads on the axes on/off or |selected
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change the number of subdivisions
or units to display

All Properties. . . | Lets you edit the display One or several
properties of the selected object |similar objects are
(s) selected
[Convert to Deletes the selected constraint A constraint is
Calculation and calculates the equivalent selected
(Output)] output
[Convert to Changes the calculation to an An output
Constraint (Input)] input constraint expression is
selected
[Convert to Real] 'Changes a symbolic output to a A symbolic output
real output value expression is
selected
[Convert to Changes a real output value to a | A real output value
Symbolic] symbolic output expression is selected

Visibility Condition

You can set any mathematical condition for one or more object's visibility.
Use this with the Animation tools for some great effects. Here are the
steps:

1.Select the object(s) that you want to change visibility.
2.Right-click and select Visibility Condition from the Selection Context
menu.

3.Enter the expression for a defined variable for which you would like your
object(s) to be visible.

Here's an example. Point C is t proportional along the parabola. In the first
figure the picture is hidden. When the picture was visible, we set the
Visibility Condition to: |t| >=0 AND |t| <0.3. With the Animation tools
we set t from -1.5 to 1.5. As point C approaches the top of the arc, BOOM!
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Editing the Color List

Use the Context menu to chang colors of any elements in your drawing.
When you select Point / Line / Fill / Text Color the 16 color pallet
appears. If you don't like the color choices you can edit the list in 2 ways.
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= Black

= Blue

= Brown

m (47,47,47)

= (47,79,47)

= Gray
Green
(191,216,216)

= Fuchsia

= Orange

= Red
Yellow

= Purple

= Navy
Silver
White

Edit color list...

Edit Color List

1 .Black
2 .Blue
3 .Brown

4 .(47,47,47)

H.(47,79,m)

6

DGreen

7
8 D(191,216,21 6)

9 .Fuchsia
10 .Orange
11 .Red

X
A
Bring up the color
palette to select a color
edit RGB values
v
Cancel

First click the Edit color list, then:
e change the RGB values in the list or

e click the

187

to bring up the color pallet and select a replacement color

Here are the steps for creating a color in the color pallet and replacing it in

the list:

1.Click the color to be replaced from the Custom colors.
2.Move the cursor (click-and-drag) in the pallet to select your color

3.Adjust the Luminance by dragging the slider on the right side of the

pallet or changing the value in the data window. You can also adjust the
color by changing other values in the data windows - Hue, Saturation

and RGB.

4.Check the resulting color in the Color/Solid box. Readjust if necessary.
5.Click Add to Custom Colors to replace the selected Custom color.
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Colour x

Basic colours:

I |

[ |

] |

HEN |

HEN i 3.

HEE I

Custom colours:

N R =] =]
1. Sat: Green:

Define Custom Colours >> Lum: 120 Blue: 193

H

K Cancel 5.{Add to Custom Colours

You can return to step 1. to change another color in the list.

Click OK to return to the Edit Color List dialog with your new replacement
color(s), or Cancel change your mind and use the Color List as it was.

The new Color List will be saved until you change it again.
Tracing Points

You can select one or more points to see a trace of their path when
dragging or moving the diagram. Here are the steps:

e select the point(s) to trace

e right-click to get the Context menu

e Select Point Properties / Point Trace / Yes

Click-and-drag or animate the drawing to see the trace. When you click
again (or animate again) the last trace disappears and a new one is
created. The difference between constructing a Locus and drawing a Point

Trace is the Locus creates a mathematical function, a Point Trace does
not.

A nice example of the Point Trace is the pantograph.
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Pantograph trace of C& F
dragging C

trace of F& C
dragging point B

The trace color can be changed from the Context menu under Line
Properties / Line Color.

Axes Display Properties

The Axes Display can be set in the default settings, Edit / Preferences
under the Grid, Axis, Page tab, or you can change them for an individual
drawing from the Selection Context menu.
To invoke the Selection Context menu:

1.Select one or both axes

2.Right click the mouse

Submenu choices include:
e Axis Arrow - which lets you put arrowheads and / or labels on the
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selected axes.

A

t-1

Cut

Copy

Copy As

Paste

Delete

Hide

Arrange
Construct
Visibility Condition...
Axis Arrow
Axis Properties
Line Properties
Text Properties
All Properties...

Y

Cut

Copy
Copy As
Paste
Delete
Hide
Arrange

Construct

Ctrl+H

Visibility Condition...

Axis Arrow

Axis Properties
Line Properties
Text Properties
All Properties...

A

Arrow
Arrow And Label

Show Labels
Subdivisions
Units

>

>

e All Properties - brings up the Display Properties dialog for the axes.
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Display Properties X
-] Axes ~
Line Color .Black
Line Style Solid
Line Thickness 1
Font 10; Arial; Normal; Normal; Not Underlined; Swiss;

Show Labels

Subdivisions Decimal

Visibility Condition|Degrees

Radians/3 -

You can configure the X and Y axes in many ways. There are the usual
attributes of lines and text.

e Show Labels - is useful when the axis labels lie under some part of your
diagram making it hard to read.

o To turn these off select one or both axes and click the checkbox
(unchecked).

o To turn labels on again, make your selection and click the box to display
the checkmark (it's a toggle).

e Units - can be set to the usual decimal, but with trig functions you may
find the Degrees or Radians units more appropriate.

@ No matter what your units, for trig functions, don't forget to set your
Angle Mode to Radians on the status bar.
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Cut

Copy

Copy As >
Paste
Delete
Hide Ctrl+H
Arrange >
Visibility Condition...

Axis Arrow >
Axis Properties >
Line Properties >
Text Properties >
All Properties...

Y=sin(X)

90° 180

Show Labels >
Subdivisions >

Units N > Decimal

Cut
Copy
Copy As
Paste
Delete
Hide Ctrl+H
Arrange

Visibility Condition...

Axis Arrow

Axis Properties

Line Properties

Text Properties

All Properties...

>

>

>

270°

v Degrees

Radians

Radians/3

Y=2-arcsin(X)

TTT/4

Y=arctan(X)

Show Labels >
Subdivisions >
Units I

- /

Tool Bar

b

> Decimal
Degrees

v Radians
Radians/3

The icons across the top of the screen make some of the routine tasks in
the File, Edit, and View menus, and Help easily accessible.

% - See The Selection Arrow for more information.

NEH & &
XDE5 R SO
Qe wWHERA Y # %

- See File Menu for more information.

- See Edit Menu for more information.

- See View Menu for more
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information.

dp ‘Qp - See Output Calculations for more information.

neEgm See Customizing Your Display for more information.
@ Invokes the embedded Help facility
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What's New in Geometry Expressions?

A new version of Geometry Expressions, v4.0, has a new user interface,
inspired by GXWeb, blending familiarity with innovation. The updated
design makes navigation intuitive, helping you find what you need quickly.

Explore these improvements today and see how the new design enhances
your workflow!

Where is the Geometry Expressions Website?

Information on upgrades, additional technical support and loads of great
examples can be found on the Geometry Expressions website at:
www.GeometryExpressions.com.

Can | See Some Examples?

Yes! We're on YouTube!

You can also sign up for a live Webinar. Send us a note and we'll get back
to you with a date and time.
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ActionScript 170

adjusting
drawing 68
text size 178
angle

annotation 104
bisector 91
calculate 113
constraint 78
mode 15
reflex calculation 114
supplement calculation 114
animation 135
console 137
duration 137
export file 147
modes 137
parameter based 138
values 137
with Locus tool 138
annotation 101
angle 104
coefficients 107
congruent 107

congruent angle 108
coordinate 106
direction 105
distance 102
distinguish from constraints 71
expression 110
length 102
parallel 109
perpendicular 103
radius 103
slope 106
symbols 128
text 51
Applets 147, 156
Inputs 160
Multiline Text Box 155
Ul Types 160
Arcs 45
Area between curves 46
area calculation 116
area under the curve 100
assumptions 121
axes 38
display properties 189
scaling 164
units 189

_B -

Background color 20
bisector
angle 91
perpendicular 90
built-in functions 125

_C-

CcC 170

C# 170

C++ 170

calculations 111
angle 113
area 116
coordinates 116
direction 115
distance / length 112
implicit equations 118
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calculations 111
parametric equations
perimeter 117
radius 113
slope 115
vector coefficients

Calculus 100

check boxes

circles 41

coefficients
annotation 107
constraint 80

colors
Editing the Color List

conflicts, constraint 74

congruence 82
angle annotation
annotation 107

constraints 69
angle 78
changing 71
conflicts 74
congruent line segments 82
coordinate 80
direction 79
distance 76
distinguish from annotations 71
equation 83
incident 81
length 76
parallel line segments 83
perpendicular 77
point proportional along curve 84
radius 77
slope 79
system added 72
tangents 81
vector coefficients 80

constructions 87
angle bisector 91
area under arc 100
dilation 95
intersection 89
locus of points 95
midpoints 89
parallel 91
perpendicular bisector 90
perpendicular lines 92

118

117

122

186

108

reflection 93

rotation 94
tangent 92
trace 97

translation 94
Context Menus 180

Editing the Color List

Visibility Condition
Convert to

Input / Output

Symbolic / Real
coordinates

annotation 106

calculation 116

constraint 80

186
185

182

182

copy and paste mathematics

Copy As
mathematics
MathML input
String input 167

curve approximations

Curvilinear polygon

D -

Dashboard Widgets
Defaults 24
text font 52
degrees 15
dilation 95
direction
annotation 105
calculate 115
constraint 79
Display 14
customizing 18
output properties

Settings 24
distance

annotation 102

calculation 112

constraint 76

167
167

49
46

159

119

32

Distinguish Constraints / Annotations 71

division editing tool

drawing
adjusting 68
arcs 45

126
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drawing
circles 41 F
constraints 69

curve approximations 49
ellipses 42
expressions 54
hyperbola 44

line segments 38

Figure Gallery
controls 143
Import 141
File Handling 28
workbooks & individual files 29

Ilnesb I38 4s File Menu 140

pa_rat 0 az , Export 144

po:n S 4o Import from the Figure Gallery 141
polygons

functions 18, 55
built-in 125
cartesian 56

Preferences and Properties 36
regular polygons 48

text 51 domain 59, 61
tools 36 fX) 57
vectors 39 handles 56, 59, 61
list 133
- E - parametric 61
piecewise 63
Edit Menu 165 polar 59
Copy As 167
Preferences 24 _ G _
Settings 24
ed?tingthecolorlist 186 Graphing mode 164
Ellipse 42 Greek letters 130
envelope 95
Equations
constraint 83 - H -
implicit 83
implicit: calculating 118 help
examples 34 using the Help system 11
exporting drawings 144 Help Menu 180
Animation files 147 Hide, toggle 182
HTML 145 HTML export files 145
Image files 145 Hyperbola 44
JavaScript Applet animated example 152
JavaScript Applet example 150 - I -
JavaScript files 147
Lua applets 156 Icon Bar 192
widgets 159 image export 144
Expression Image export files 145
annotation 110 Import files
Draw tool 54 from the Figure Gallery 141

incidence 37, 81
Input constraints 69
integrals 100
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intermediate veriables 121
intersections 89

_J -

Java 170

JavaScript export files 147
animated example 152
example 150
using multi-line functions 152

JavaScript, Source code 170

S L -

length
annotation 102
calculation 112
constraint 76

line
infinite 38
intersections 89
parallel construction 91
segments 38

linked text 11

locking variables 135
using the lock 134

locus of points 95
curves and animation 138

Lua Apps 156, 158

M -

Math Operations 125

MathML 32, 167

Menus

Annotate 101
Calculate (Output) 111
Constrain (Input) 69
Construct 87

Context 180, 181, 182
Draw 36
Edit 165
File 140
Help 180
View 176
Metafile 144

midpoints 89
move the drawing 68
multiple drawings 28

_N -

New features 196
N-gons 48

_0 -

Objective C 170

Operations 125

output
assumptions 121
calculations 111
check boxes 122
name 122
properties 119
window 176

_P-

page tabs 28
arranging 19
pantograph 188
Parabola 43
parallel 83
annotation 109
construction 91
parametric equations
output 118
Parametric Variable 95, 97
parentheses for math notation
perimeter calculation 117
perpendicular
annotation 103
bisector 90
constraint 77
construction 92
Pictures 52
Piecewise Functions 63
parametric example 65

points 37
constrained along a curve
tracing 188

127

84
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polygons
construction 93
drawing 40
regular 48
Preferences 24
Properties
Axes 189

Point - trace 188

R -

radians 15

radius
annotation 103
calculate 113
constraint 77

Reflection 93

reflex angle 78

reflex angle calculation 114

rotation 94

_S -

Scale 68,178
scaling the axes 164
screen layout 14
selecting
geometry 67
multiple objects 67

Settings 24
show output 122
slope

annotation 106
calculate 115
constraint 79
Smartboard Mode 68
source code 170
examples 171
square root editing tool 127
status bar 15
subscript / superscript 127
supplemetary angle calculation
symbols 125
division 126
Greek letters 130
parentheses & absolute value
square root 127

subscript / superscript 127

- T -

tangents 81, 92
text 51

Edit Text dialog 52

size 178
TI-Nspire

Script Editor 158
Toolbox Menus 179
Trace 97
tracing points 188
translation 94

_V -

variables 18, 132
functions list 133
list 133
locking 135
value 135
Variables and Functions 18
VBA 170
vectors
calculate coefficients 117
constraints: coefficients 80
drawing 39
View Menu 176
Visibility Condition 185
Visual Basic 170

W -

Widgets 159
Workbook files 29
workspace 28

_7 -

Zoom 68,178

201
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